Polar PCB Lossy Line GHz Test System

Operator Manual

ATLAS

Polar Instruments Ltd

Polar Instruments Ltd.
Garenne Park
Rue de la Cache
St. Sampson's
Guernsey
Channel Islands
GY2 4AF
UK

www.polarinstruments.com

e-mail: polarcare@polarinstruments.com

MAN 203-1604
ATLAS OPERATOR MANUAL

POLAR INSTRUMENTS LTD.

COPYRIGHT

Copyright 2016 © by Polar Instruments Ltd. All rights reserved. This software and accompanying documentation is the property of Polar Instruments Ltd and is licensed to the end user by Polar Instruments Ltd or its authorized agents. The use, copying, and distribution of this software is restricted by the terms of the license agreement.

Due care was exercised in the preparation of this document and accompanying software. Polar Instruments Ltd. shall not be liable for errors contained herein or for incidental or consequential damages in connection with furnishing, performance, or use of this material.

Polar Instruments Ltd makes no warranties, either expressed or implied, with respect to the software described in this manual, its quality, performance, merchantability, or fitness for any particular purpose.

DISCLAIMER

Disclaimer of Warranties. POLAR MAKES NO OTHER WARRANTIES, EXPRESS, IMPLIED OR STATUTORY, REGARDING PRODUCTS. ALL OTHER WARRANTIES AS TO THE QUALITY, CONDITION, MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT ARE EXPRESSLY DISCLAIMED.

Limitation of Liability. POLAR SHALL NOT BE RESPONSIBLE FOR DIRECT DAMAGES IN EXCESS OF THE PURCHASE PRICE PAID BY THE END USER OR FOR ANY SPECIAL, CONSEQUENTIAL, INCIDENTAL, OR PUNITIVE DAMAGE, INCLUDING, BUT NOT LIMITED TO, LOSS OF PROFITS OR DAMAGES TO BUSINESS OR BUSINESS RELATIONS, WHETHER OR NOT ADVISED IN ADVANCE OF THE POSSIBILITY OF SUCH DAMAGES, THE FOREGOING LIMITATIONS SHALL APPLY, NOTWITHSTANDING THE FAILURE OF ANY EXCLUSIVE REMEDIES.

Copyright Polar Instruments Ltd. ©2016

Microsoft, MS-DOS, Microsoft Windows, Windows 7, Windows 8 and Windows 10 are registered trademarks of Microsoft Corporation.

IBM is the registered trademark of International Business Machines Corporation.
DECLARATION

EUROPEAN COMMUNITY DIRECTIVE CONFORMANCE STATEMENT

This product conforms to all applicable EC Council Directives, including:


A declaration of conformity with the requirements of these Directives has been signed by:

POLAR INSTRUMENTS EUROPE LTD
23 The Parkwood Centre, Aston Road
Waterlooville
Hampshire
England PO7 7HT

Harmonised standards applied in order to verify compliance with these Directives:

EN 61326:1998
EN 61010-1:2010
CAUTION

Electrical Isolation
Always disconnect the board/coupon under test from the local mains supply (including ground) before using Atlas and its associated measurement system (TDR). The system applies test voltages to the item under test. Make sure that the item under test is isolated from all other sources of electrical power. External power could damage the tester.

Static sensitive devices

*IMPORTANT! The TDR unit contains static sensitive devices. Observe static precautions at all times.*

Consult Appendix A – *PROTECTING THE TDR FROM ELECTROSTATIC DISCHARGE* prior to operation.
SPECIFICATIONS

Insertion Loss measurement

- $S_{DD21}$ insertion loss measured using Delta-L technique.
- SPP (Short Pulse Propagation) to IPC-TM-650 2.5.5.12A Test Methods Manual.
- Extracts propagation constant (attenuation and phase constant), dielectric constant and characteristic impedance.
- $S_{DD21}$ magnitude v frequency over the widest range practicable for a coupon of defined characteristics. $S_{DD21}$ differential insertion loss measured using the Bidirectional SET2DIL method and industry standard SET2DIL coupon.
- Single ended insertion loss measured with SET2SEIL
- Test limits per test: Unlimited number of minimum / maximum values for insertion loss v frequency. Measurement accuracy relies on the use of approved SET2DIL probe sets.

Impedance measurement

- Single ended and differential impedance — results presented graphically. Range of measurement available determined by TDR used — see manufacturer's specification for details
- Average impedance: specified in Ohms/Rho (reflection coefficient)
- Test limits: inches/mm or units of time
- Accuracy specifications: as defined by the TDR manufacturer

Data logging and output

- All tests data logged and output as pipe delimited text files for customer processing. Data export in CSV format.
- Printable test lists and waveforms

Third party probe

- Delta-L — LiTek type Prb-100-P10-2BM
- SET2DIL — GGB Picoprobe type TLP-1 450 micron GSSG with cables (bandwidth to 20GHz, phase matched)

Bandwidth monitoring

- Real time monitoring of system bandwidth

Hardware

- Compatible measurement system (customer supplied)
- Currently supported TDR: Tektronix DSA8300 with 80E04 plug-in; legacy Tektronix measurement systems, e.g. the DSA8200 or TDS8000, may return acceptable results but only qualify for limited support.
- Atlas 800 ESD Protection Module
### SYMBOLS

⚠️ **CAUTION** Connect to PC USB using cable supplied only.

⚠️ **CAUTION** Static sensitive devices — observe static precautions.

*Note: The TDR contains static sensitive devices — observe static precautions at all times.*

### PERSONAL COMPUTER REQUIREMENTS

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computer</td>
<td>IBM PC or compatible</td>
</tr>
<tr>
<td>Processor</td>
<td>Pentium 2GHz or better</td>
</tr>
<tr>
<td>Operating system</td>
<td>Microsoft Windows 7 or later</td>
</tr>
<tr>
<td>System memory required</td>
<td>1 GB (4GB recommended)</td>
</tr>
<tr>
<td>Hard disk space required</td>
<td>1 GB (min.)</td>
</tr>
<tr>
<td>Video standard</td>
<td>SXGA+ (1400 x 1050 min.)</td>
</tr>
<tr>
<td>Mouse</td>
<td>Microsoft compatible</td>
</tr>
<tr>
<td>Communication ports</td>
<td>3 available USB 2.0 ports</td>
</tr>
<tr>
<td>Network connection</td>
<td>TCP/IP Ethernet connection for communication with compatible measurement system (one static IP address is required for compatible measurement system)</td>
</tr>
</tbody>
</table>
ACCESSORIES

Standard Accessories

Operator manual MAN203
Wrist band ground cord ACC185
USB footswitch ACC383
USB 2.0 cable ACC371
Antistatic wristband ACC175
GGB Probe ACC396
Probe holder ACC397
Coaxial cable WMA361
USB Cable ACC371
RF Cable WMA369
Torque wrench ACC313

Optional Accessories

CGen Si Insertion Loss coupon Generator
GUIDE TO THE MANUAL

<table>
<thead>
<tr>
<th>SECTION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>INSTALLATION/SET UP</td>
<td>Atlas software licensing. Connecting the host PC to the measurement system, installation of Atlas and connectivity software and preparation for use. Specifying the PC and measurement system network addresses. Configuring the Atlas system and operating environment.</td>
</tr>
<tr>
<td>GETTING STARTED</td>
<td>Introduction to basic Atlas operation. Using Atlas in demonstration mode.</td>
</tr>
<tr>
<td>THE TEST FILE EDITOR</td>
<td>Description of test parameters — creating, writing and saving test files for both loss and impedance testing.</td>
</tr>
<tr>
<td>APPENDIX A</td>
<td>Notes on static sensitive devices and preventing damage to the TDR.</td>
</tr>
<tr>
<td>APPENDIX B</td>
<td>Description of Atlas 800 ESD Protection Unit. Safety and operating information.</td>
</tr>
</tbody>
</table>
OPERATING ATLAS

The Atlas software is designed for use within the Microsoft Windows environment (Windows 7 or later). Familiarity with the Microsoft Windows environment is assumed. For more information on Microsoft Windows operation consult the appropriate Microsoft Windows User Guide.

Atlas functions are controlled by clicking the toolbar buttons with the mouse or selecting the associated commands from pull-down menus.

Selecting commands

Using the keyboard
Activate the Atlas menu bar by pressing the Alt key on the keyboard.
Press the underlined letter in the menu name to display the menu command list.
Press the underlined letter in the command name.

Using the mouse
To display a command list, point to the menu name and click the left mouse button.
Point to the command name and click the left mouse button.
Selecting a command name which is followed by ellipses (...) displays a dialog box containing options which qualify the command.
Clicking the OK button corresponds to pressing the <CR> or <Enter> key on the keyboard.
Clicking the Cancel button corresponds to pressing the <Esc> key on the keyboard.
## CONTENTS

**DECLARATION**  
EUROPEAN COMMUNITY DIRECTIVE CONFORMANCE STATEMENT

**STATIC SENSITIVE DEVICES**  
- Electrical Isolation  
- Static sensitive devices

**SPECIFICATIONS**

**SYMBOLS**

**PERSONAL COMPUTER REQUIREMENTS**

**ACCESSORIES**  
- Standard Accessories  
- Optional Accessories

**GUIDE TO THE MANUAL**

**OPERATING ATLAS**  
- Selecting commands  
  - Using the keyboard  
  - Using the mouse

**CONTENTS**

**CONTROLLED IMPEDANCE/LOSS TESTING**

- 1-1 The ATLAS system  
- 1-2 Test files  
- 1-3 Data analysis  
- 1-4 Atlas features  
  - User interface  
  - Board testing  
  - Data logging  
  - Display (Loss)  
  - Display (Impedance testing)  
    - Launch point extrapolation (LPE)  
- 1-5 Test coupons  
  - Probe connection  
  - Coupon loss testing styles
SETTING UP THE ATLAS SYSTEM

2-1 Installing the ATLAS software
   Installing the program
   Installing TekVISA
      VXI-11 Server
   Installing MATLAB

2-2 Connecting the computer to the Atlas 800
   Connecting Atlas 800 to the USB communication port

2-3 Installing the USB driver
   Installing the USB driver on Windows 7
   Installing the USB driver on Windows 8/10
   Installing the USB driver on 64-bit Windows 8/10

2-4 Atlas software licensing
   Obtaining a license
      Installing the USB key driver
      Requesting a license
      Specifying the license file

2-5 Controls and connectors
   Probe SMA connectors
   USB Foot switch
   Wrist strap/Ground

2-6 Connecting the host computer to the TDR

2-7 Configuring the DSA8300
   Setting up the workgroup

2-8 Configuring the host PC
   Windows 7/8

2-9 Configuring Atlas

2-10 Updating the TekVISA Instrument List

2-11 Running the program

2-12 System configuration
   General options
      Show All Menu Options
      Enable Demonstration Mode
      Results to Right of Waveform
      Choosing display cursors
      System security
      Specifying a password
      Activate on Exit
      Controlling test file editing permissions
      Edit Default Test

   TDR options
   Colours
   Datalog and Snapshot settings
   Prompts
      Confirmations
      Auto Advance options
   Displaying license information
   Displaying cautions
   Specifying Loss options
   Exporting Intel SET2DIL files
## FIRST TIME ATLAS OPERATION

- **3-1 The Atlas screen**
- **3-2 The Atlas tool bar**
- **3-3 Demonstration Mode**
  - Using demonstration mode
  - Impedance testing
    - Horizontal display units
    - Vertical display units
    - Tolerance
    - Test From and Test To
    - Executing an impedance test
    - Editing the test file
    - Displaying the impedance statistics
  - Loss testing
  - SET2DIL tests
    - Specifying the Configuration
    - Channel Selection
    - Choosing the number of averages
    - Choosing the number of data points
    - Reference line lengths
    - Setting test limits
    - Running the test
- **3-4 Exiting the program**

## USING ATLAS

- **4-1 Starting ATLAS**
- **4-2 The Atlas screen**
  - Test List window
  - Waveform Display window
  - Datalog Results Window
- **4-3 The Atlas menu bar**
  - The File menu
  - The Board menu
    - Creating and editing board tests
    - Exporting Atlas waveforms
    - Export Waveform
    - Board information
  - The Datalog menu
  - The View menu
    - Displaying statistical data
    - Display Data Points
    - Display Source Waveforms
    - Display Result Table
    - Display Cursor Readout
  - The Utilities menu
    - Config...
    - Diagnostics
    - Locate EOP and Align Pulser / Sampler...
    - Erase Thru Waveform (SET2DIL)
SET2DIL Deskew 41
Export Intel SET2DIL File sets 41
The Help menu 42
4-4 The Atlas tool bar 43
4-5 The Waveform Display window pane 44
Impedance tests 44
Displaying the impedance statistics 44
SET2DIL Loss tests 45
SPP tests 46
Impulse forming networks 46
Delta-L tests 46
The Waveform Display shortcut menu 47
Display Data Points 47
Display Source Waveforms 48
Export waveform 48
4-6 The Test List 48
Adding columns to the Test List 48
4-7 The Datalog 49
4-8 The Status bar 50
4-9 End of Probe (EOP) calibration 51
Adjusting the Atlas SET2DIL deskew value 51
SET2DIL calibration 52
Locating end of probe & pulser/sampler alignment (SPP) 53
SPP calibration 53
Delta-L calibration 54
4-10 Testing printed circuit boards 55
SET2DIL, SET2SEIL measurements 56
SPP measurements 56
Delta-L measurements 56
Selecting a test file 57
Arranging the test list 57
4-11 Executing impedance tests 58
Displaying test results 58
Launch point extrapolation 59
4-12 Executing loss tests 60
SET2DIL tests 60
Acquiring a coupon reference waveform 61
Running SET2DIL tests 66
Erasing the Thru waveform 67
SPP tests 68
Typical SPP coupon connectors and terminology 68
Atlas SPP 68
Creating a new SPP test 69
Locating end of probe & pulser/sampler alignment 69
Running the SPP test 70
Pre screen impedance long line forward direction 70
Pre screen impedance long line backward 71
Pre screen impedance short line forward 71
Pre screen impedance short line backward 72
SPP test long line 72
SPP test short line 73
Reviewing test results 74
Using the on screen cursors 75
Delta-L tests 76
Long line test 76
Short line test 76
Reviewing test results 77
Using the result table 77
Deleting test results 78
Saving test results 78
Saving the results of a single test 78
Saving all test results (snapshots) 78
Viewing all test results (snapshots) 78

4-13 Logging Test Data 78
Auto Advance 78
The Data Log window 80
Exporting the Datalog in CSV format 81
Exporting SET2DIL data 81
Exporting SPP data 81

4-14 Exiting the Atlas program 81

TEST PARAMETER FILES 83

EDITING TEST FILES 83
5-1 The Test Setup Editor 83
Impedance test parameters 83
5-2 Creating and modifying test files 84
Creating a new test file 84
Inserting tests 84
5.3 Inserting Impedance tests 85
Impedance test parameters 86
Description 86
Layer 86
Impedance 86
Probe Channel Selection 86
Single-Ended Tests 86
Differential Tests 86
Horizontal Units 87
Setting Vp for distance units 87
Start Display at 88
Test from 88
Test to 88
Vertical units 89
Tolerance 89
Launch point extrapolation 89
5.4 Inserting SET2DIL tests 91
Configuration 91
Specifying deskew 91
SET2DIL test parameters 92
Channel Selection 92
Choosing the structure type 92
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test Description</td>
<td>92</td>
</tr>
<tr>
<td>Specifying the Layer</td>
<td>92</td>
</tr>
<tr>
<td>Specifying the number of averages</td>
<td>92</td>
</tr>
<tr>
<td>Specifying the number of data points</td>
<td>92</td>
</tr>
<tr>
<td>Specifying trace line lengths</td>
<td>93</td>
</tr>
<tr>
<td>Setting test limits</td>
<td>93</td>
</tr>
<tr>
<td>Specifying a minimum limit value</td>
<td>94</td>
</tr>
<tr>
<td>Adding a new limit</td>
<td>94</td>
</tr>
<tr>
<td>Modifying a limit setting</td>
<td>94</td>
</tr>
<tr>
<td>Deleting a limit setting</td>
<td>94</td>
</tr>
<tr>
<td>Evaluating against a line fit</td>
<td>95</td>
</tr>
<tr>
<td>5.5 Creating and editing SPP tests</td>
<td>95</td>
</tr>
<tr>
<td>Setting the SPP pretest parameters</td>
<td>96</td>
</tr>
<tr>
<td>Pretest parameters</td>
<td>96</td>
</tr>
<tr>
<td>Choosing the SPP configuration</td>
<td>97</td>
</tr>
<tr>
<td>Prescreen single-ended impedance parameters</td>
<td>97</td>
</tr>
<tr>
<td>Prescreen differential impedance parameters</td>
<td>97</td>
</tr>
<tr>
<td>Long line regression fit</td>
<td>97</td>
</tr>
<tr>
<td>Specifying the number of averages</td>
<td>97</td>
</tr>
<tr>
<td>Pre screen test limits</td>
<td>97</td>
</tr>
<tr>
<td>Setting the SPP parameters</td>
<td>98</td>
</tr>
<tr>
<td>Specifying the number of averages</td>
<td>98</td>
</tr>
<tr>
<td>Specifying the impulse forming network type</td>
<td>98</td>
</tr>
<tr>
<td>Reference line lengths</td>
<td>98</td>
</tr>
<tr>
<td>Setting test limits</td>
<td>98</td>
</tr>
<tr>
<td>Specifying a minimum limit value</td>
<td>99</td>
</tr>
<tr>
<td>Adding a new limit</td>
<td>99</td>
</tr>
<tr>
<td>Modifying a limit setting</td>
<td>99</td>
</tr>
<tr>
<td>Deleting a limit setting</td>
<td>99</td>
</tr>
<tr>
<td>5.6 Creating and editing Delta-L tests</td>
<td>100</td>
</tr>
<tr>
<td>The Delta-L test editor</td>
<td>100</td>
</tr>
<tr>
<td>Delta-L test parameters</td>
<td>100</td>
</tr>
<tr>
<td>Description</td>
<td>100</td>
</tr>
<tr>
<td>Delta-L configuration</td>
<td>101</td>
</tr>
<tr>
<td>Layer</td>
<td>101</td>
</tr>
<tr>
<td>Data points</td>
<td>101</td>
</tr>
<tr>
<td>Specifying the number of averages</td>
<td>101</td>
</tr>
<tr>
<td>Timebase and line lengths</td>
<td>101</td>
</tr>
<tr>
<td>Setting test limits</td>
<td>102</td>
</tr>
<tr>
<td>Adding a new limit</td>
<td>102</td>
</tr>
<tr>
<td>Modifying a limit setting</td>
<td>102</td>
</tr>
<tr>
<td>Deleting a limit setting</td>
<td>102</td>
</tr>
<tr>
<td>Specifying a minimum limit value</td>
<td>103</td>
</tr>
<tr>
<td>5.7 Saving the test file</td>
<td>103</td>
</tr>
<tr>
<td>Naming test files</td>
<td>103</td>
</tr>
<tr>
<td>Reserved characters and names</td>
<td>104</td>
</tr>
<tr>
<td>Saving test files under new names</td>
<td>104</td>
</tr>
<tr>
<td>5.7 Using existing files as templates</td>
<td>104</td>
</tr>
<tr>
<td>5.8 Printing test files</td>
<td>104</td>
</tr>
</tbody>
</table>
ELECTROSTATIC DISCHARGE A-1

ATLAS 800 ESD PROTECTION UNIT B-1

ATLAS 800 SAFETY B-1

Grounding B-1
Power supply B-2
Operating the Atlas 800 B-2
Electrical Isolation B-2
Static sensitive devices B-2

ATLAS 800 SPECIFICATIONS B-3

ATLAS 800 ENVIRONMENTAL OPERATING CONDITIONS B-3

Power requirements B-3
Physical characteristics (excluding accessories) B-4
Symbols B-4
Lifting and carrying B-4
Cleaning B-4

ATLAS 800 OPERATION B-5

Connectors B-5
SECTION 1 — INTRODUCTION

CONTROLLED IMPEDANCE/LOSS TESTING

1-1 The ATLAS system

Polar Instruments’ Atlas insertion loss and impedance testing software is designed for use with compatible third party TDR measurement systems for PCB fabricators who need to add insertion loss measurement capability to their facility.

It provides simple and meaningful insertion loss measurement methods for PCB fabricators with appropriate data logging and documentation of test results.

In addition to the currently supported test methods Atlas allows for addition of further test types and hardware as requirements become apparent.

Atlas provides easy to use graphical testing both of single ended and differential insertion loss and impedance of single-ended and differential printed circuit board traces and test coupons.

Connection between the TDR and boards under test is achieved using compatible third party probes or appropriately torqued SMA cables and connectors.

The Atlas software is written to run within the Microsoft Windows environment, so test result waveforms may be printed out using the currently installed printer.

A USB plug-in foot-switch is included with the Atlas system to free up both hands during testing.

1-2 Test files

All the information necessary for performing a controlled impedance or loss measurement on a circuit board or test coupon is stored in a test file. An operator only needs to select the appropriate test file from a list and the system is ready for testing.

Test files are easily created and modified via the integrated test file editor — most files will be created with just a few keystrokes and mouse clicks. Test files provide a convenient mechanism for automated testing of boards with a number of different loss or controlled impedance traces.
1-3 Data analysis

All test results are displayed on the PC screen in waveform and statistical form for rapid analysis. Waveforms may also be stored to disk for later inspection.

Test data may be logged for subsequent statistical analysis. The stored data may be printed out or imported into a spread sheet or database.

Atlas also generates data in delimited format (suitable for importing into a spread sheet or database) for statistical process control (SPC) analysis.

Loss test results are displayed as linear or logarithmic graphs of loss against frequency. Impedance tests chart impedance against time or distance along a PCB track. PASS or FAIL results are returned according to whether or not the loss reads within limits at the specified frequencies or the impedance remains within tolerance over the full length of the tested region, using a range of test methods. For impedance tests, the average, minimum and maximum impedance values over the tested region are displayed on screen along with the measured waveform.

1-4 Atlas features

The Atlas system is designed to make the complex process of insertion loss and impedance testing as rapid and simple as possible. Atlas includes the following features:

User interface

Graphical presentation of insertion loss against frequency or trace impedance over distance or time in both metric or U.S. units

Industry standard Microsoft Windows 7/8/10 environment

Mouse driven user interface for ease of use

Board testing

Up to eight channel testing (using Tektronix DSA8300 and 80E04 sampling modules)

Dramatic reduction in loss testing times compared with traditional methods. Using the Delta-L, SET2DIL or SET2SEIL test methods insertion loss tests can be performed in seconds, compared with the minutes or hours of other, traditional techniques. SPP tests are performed in just a few minutes.

Impedance test method supports measurement of comprehensive range of impedance values

ESD protection with the Atlas 800 ESD Protection Module
Optional Polar Instruments manufactured probe systems include robust mechanical registration pins to provide easy connection to the board under test and protection for the signal interconnect pins. Degradation of the TDR sampling heads is minimised by the use of materials with high ESD dissipation characteristics for Polar probe construction.

Automatic instrument set up
Integrated test file editing

Data logging
Rapid data logging of test results
Statistical analysis for process control
Disk storage of test results
Hard copy of test & stored results

Display (Loss)
Display of insertion loss per unit distance within user-definable limits against linear or logarithmic frequency. Loss values displayed include raw, linear line fit or root line fit along with coefficient of determination ($R^2$) for SET2DIL and SET2SEIL tests and $y$-axis intercept.

Display (Impedance testing)
Linear display of impedance against distance (in U.S. or metric measurements) or time
Impedance display in Ohms, Rho or mRho
On-screen display of waveform statistical analysis
Simple Pass/Fail PCB track test results displayed in waveform window

Launch point extrapolation (LPE)
Launch point extrapolation (LPE) uses line fitting to the impedance trace. LPE can better reflect the impedance that the signal sees as it launches into the trace. This can be beneficial with very thin copper and narrow traces.

1-5 Test coupons
Atlas tests for loss using the Delta-L, SPP (Short Pulse Propagation Bidirectional), SET2DIL (Single Ended TDR to Differential Insertion Loss) and SET2SEIL (Single Ended TDR to Single-Ended Insertion Loss) loss testing methods.

Optional accessory CGen Si Coupon Generator (v14.02 and later) includes coupon styles that support the SPP, SET2DIL and SET2SEIL loss testing methods and associated probe
pin layouts. CGen Si allocates structures using structure interleaving to optimise the use of available coupon space. Typical Polar Atlas probe pin layouts are shown in the sample coupons below.

**Probe connection**

One of the most critical areas of coupon design is matching the test probe to the coupon interconnect. CGen Coupon Generator allows you to pick from a list of the industry's most frequently used probes for both impedance and loss test systems. The interconnect for the chosen probe is then automatically engineered into the artwork.

**Coupon loss testing styles**

CGen includes a coupon style for the GGB Picoprobe. The coupon below illustrates the inline SET2DIL coupon with GGB Picoprobe footprint.

SPP tests include a selected set of SPP tests from the suite of tests defined by IPC-TM-650 Test Methods manual 2.5.5.12A. A typical SPP coupon with its SMA connection pads is shown below.

The coupon above incorporates both single-ended and differential stripline traces of known lengths.
SETTING UP THE ATLAS SYSTEM

2-1 Installing the ATLAS software

Installing the program

Download the Atlas installer from the Polar supplied link. The installer contains the Atlas software and MATLAB numerical computing environment.

Atlas acquires data from the Tektronix DSA8300 with 80E04 plug-ins using the VISA connectivity software — TekVISA is the Tektronix implementation of VISA, an industry-standard communication protocol.

Installing TekVISA

TekVISA is available from the Tektronix web site. Download to a suitable folder and run the installer.

The connectivity software must be installed and running on the DSA8300 and the host PC in order to communicate data and applications between the instrument and the PC.

TekVISA provides network access to the DSA8300 by including VXI-11 client and server software components. The VXI-11 LAN Server is installed on the DSA8300 as part of the TekVISA software installation. The VXI-11 LAN Client is included as a VISA instrument resource type on the client/host PC with TekVISA software installed.

VXI-11 Server

The VXI-11 Server on the DSA8300 must be enabled. Locate the blue and gray icon in Windows Desktop taskbar (lower right-hand corner). If the icon has a red circle with a slash through it, then right click on the Icon, and select Start VXI-11 Server.

NOTE: To start VXI-11 Server automatically next time the DSA8300 is powered on select Server Properties, and Check Start server automatically at system power up. To exercise this option on DSAs with the Windows 7 or later operating systems it may be necessary to exit the VXI Server and restart with Administrator rights.
The Atlas – TekVISA – DSA8300 system communicates via Windows networking using TCP/IP over Ethernet and can be set up using the standard Windows networking dialogs. Network settings (IP addresses, subnet masks, workgroup names, etc.) are normally assigned to the controlling PC and Tektronix DSA8300 TDR under the supervision of the company/workshop network administrator.

Double click the installer and follow the instructions to install the Atlas software.

*Installing MATLAB*

Navigate to the install directory for the Polar Atlas and install the MATLAB runtime MCRInstaller.exe.

### 2-2 Connecting the computer to the Atlas 800

The Atlas 800 connects to the host computer via a USB 2.0 (or better) communication link using the Polar supplied USB 2.0 cable.

*Connecting Atlas 800 to the USB communication port*

Connect the supplied USB 2.0 cable from the Atlas 800 to the host computer's USB 2.0 port. Ensure all connections are secure.

### 2-3 Installing the USB driver

When Atlas 800 is powered up the host PC senses the presence of the Atlas 800 (see Connecting Atlas 800 to the USB communication port) it will display the Welcome to the Found New Hardware Wizard and offer to connect to the Windows Update service. Choose the “No, not this time” option and click Next.

The second dialog offers to install the Polar Win USB driver automatically or specify a driver location. Choose the “Install from a list or specific location…” option and click Next.

In the next dialog tick the “Include this location in the search:” and specify the Atlas install folder (by default C:\Program Files\Polar\Atlas for a 32-bit system or C:\Program Files (x86)\Polar\Atlas for a 64-bit system). The install folder should contain the PolarUSB.inf driver; click Next.

If Windows displays a warning relating to the Windows logo click Continue Anyway to complete the USB driver installation; click Finish.
Installing the USB driver on Windows 7

When the host PC senses the presence of the Atlas 800 (see Connecting Atlas 800 to the USB communication port) it will attempt to install the device automatically.

If it is unsuccessful, Choose Control Panel\Devices and Printers – you should see the Polar USB device listed.

Right click the icon, choose the Hardware tab and click Properties:

From the Properties dialog select the Driver tab, then click Update driver… (It may be necessary to click the Change Settings button and then choose Update Driver…)
Choose **Browse my computer for driver software** and navigate to the Atlas install folder. The install folder should contain the PolarUSB.inf driver; click **Next**.

If Windows displays a warning relating to the driver security click **Install this driver software anyway** to complete the USB driver installation.

Windows displays the Polar WinUSB Device has been successfully installed.
Installing the USB driver on Windows 8/10

With the software installed connect the Atlas 800 to the PC via the supplied USB 2.0 cable and apply power. When the host PC senses the Atlas 800 it will attempt to install the device automatically.

If unsuccessful, choose Control Panel|Devices and Printers – you should see the Polar USB device listed. Right click the icon, choose the Hardware tab and click Properties:

From the Properties dialog select the Driver tab, then click Update driver…

Choose Browse my computer for driver software and navigate to the install folder

If Windows displays a warning relating to the driver security click Install this driver software anyway to complete the USB driver installation.

Windows displays the Polar WinUSB Device has been successfully installed message.

Installing the USB driver on 64-bit Windows 8/10

By default Windows 8 or Windows 10 will not allow installation of unsigned drivers on 64-bit machines. The message overleaf warning of an unsigned driver may be displayed. In this case use Windows 8/10 Advanced Startup Options to temporarily disable driver signature enforcement.
Using the Advanced Startup Options

Press Windows key + i to access the sidebar menu and click/press the Power button; press the Shift key and choose Restart. Alternatively, press the Windows key + r to bring up a run command window: type cmd and press OK.

At the command line enter shutdown.exe /r /o (this will execute a full shutdown and restart with advanced options.) The system will restart to a Choose an option screen. Select Troubleshoot.

From the Troubleshoot screen select Advanced Options:
Select Windows **Startup Settings**—Click **Restart**. The system will restart to the **Advanced Boot Options** screen.

Select **Disable Driver Signature Enforcement**. This will disable driver signature enforcement for the current session. Once the system restarts, use the procedure above to install unsigned drivers then restart again. On subsequent restarts, driver signature enforcement will again be in place.
Obtaining a license
Atlas is licensed based on the Ethernet address of the host computer or the serial number of a FlexNet ID (USB dongle) — obtainable from Polar Instruments. It will be necessary to install the USB key driver as described in Application Notes AP620/AP607 on the Polar web site and run the lmtools.exe license utility to generate a HostID file and request a license from polarcare@polarinstruments.com

Installing the USB key driver
A copy of the FlexID USB driver is available from the Polar web site Support page. Download the key driver, double click the key installer and follow the installation instructions. It may be necessary to restart the machine. Plug in the USB key and allow Windows to detect and install the key driver fully.

Requesting a license
From the C:\Program Files\Polar\Atlas folder double click the lmtools.exe license utility and view the System Settings tab.

Click Save HOSTID Info to a File and forward the file to polarcare@polarinstruments.com to obtain the license file.
Copy the returned license file into the
C:\Program Files\Polar\Licences folder (32-bit).
C:\Program Files (x86)\Polar\Licences folder (64-bit)

Specifying the license file
Start the Atlas program (via the Windows Start menu or using the icon on the Windows desktop). During start up the software License Finder will prompt for a License File / Server location. Ensure that “Specify the License File” is selected and select Next to continue.

The License Finder prompts for the license file name. Enter the path/filename or click the Browse button to navigate to the file. (Using the Choose License File Dialog, browse to C:\Program Files\Polar\Licences and select the license file.
Select Open. The License Finder will display the license file specified. Select Next to continue. The License Finder should display its completion message. The software may display a message to indicate how many days are remaining before the license expires. Select OK to continue.

Application Note AP607 Installing Polar node locked software on the Polar Instruments web site contains further details on installing node-locked license files and associated key drivers. www.polarinstruments.com/support/installation/AP607.html
2-5 Controls and connectors

Probe SMA connectors

The Atlas insertion loss test system includes the Polar Atlas 800 ESD Protection Module to provide ESD protection for the oscilloscope and TDR module.

Connection of the probes to the Tektronix DSA8300/80E04 should normally be via the Polar Atlas 800 ESD Protection Module, designed for placing underneath the DSA8300.

*Note: When connecting probes and cables connect and tighten the Atlas probe connectors first – then connect and tighten the TDR connectors; remove in the reverse order.*

Connect the probe SMA connectors to the Probe inputs of the Atlas 800 ESD Protection Module.

Connect the TDR outputs of the Atlas 800 to the measurement system’s sampling module inputs.

*Caution: Tighten with care. Use the Polar supplied torque wrench set to 5 lbf inches ±0.3 lbf inches (0.565 Nm ±0.034Nm).*

The diagram below illustrates the connections between the probe, the Atlas 800 ESD Protection Module and the TDR sampling unit for SET2DIL and SET2SEIL tests. Delta-L and SPP tests will require two sampling units and use all four channels.

The Status lights will illuminate green when the 80E04 sampling head inputs are protected from potential static
damage by the Atlas 800 internal switching system and will momentarily change to red when a direct connection is made between the sampling inputs and probe.

**USB Foot switch**

Connect the USB footswitch (ACC383) to a USB connector on the host PC. This connector may be left disconnected if not required.

**Wrist strap/Ground**

The wrist strap socket provides a connection to the antistatic connection of the measurement system. Connect the wrist strap to the front panel of the TDR. *All testing should be performed with a known good wrist strap properly fitted.*

### 2-6 Connecting the host computer to the TDR

Communication between the host PC running Atlas and the compatible measurement system is via TCP/IP Ethernet over Cat 5 or better cable (a static IP address is required for the compatible measurement system – see *Configuring the DSA8300* and *Configuring the host PC*).

Polar application notes AP611 and AP612 describe the network setup and configuration for both company networks and direct connection.

### 2-7 Configuring the DSA8300

On many systems the network settings will be set by the local network DHCP server and will not be visible in the dialogs below – in this case, open a command prompt (choose Start| Run... and type `cmd` in the Run box). At the command prompt type `ipconfig` and note the IPv4 Address setting for the Local Area Connection:

```
Ethernet adapter Local Area Connection:
  Connection-specific DNS Suffix : 
  Link-local IPv6 Address : 
  IPv4 Address : 10.0.0.11
  Subnet Mask : 255.255.255.0
  Default Gateway : 10.0.0.1
```

If the address is not automatically assigned, the DSA8300 IP address will need to be set manually; in this case from the Windows Control Panel choose Network and Sharing Center, click Local Area Connections, in the Local Area Connection Status click Properties:
Choose Internet Protocol Version 4 (TCP/IPv4) and choose Properties – click the Use the following IP address option. Specify the IP address and subnet mask (and any other settings) assigned by the network administrator.
Setting up the ATLAS system

For this discussion, assume the example address above — your actual address will reflect your local network settings.

Note that the first three octets of the IP address should match those of the host PC; the fourth octet will be set to an adjacent address (e.g. 10.0.0.16) and the subnet mask to 255.255.255.0 Close all dialogs.

Setting up the workgroup
From Windows Control Panel chose System and click Change Settings... to view System Properties.

Note the workgroup name — it will be necessary to ensure the DSA8300 and the host PC share the same workgroup name.

Note: Changing the computer or workgroup name will require a system restart. This action must be performed on both the DSA8300 and the controlling PC.

2-8 Configuring the host PC
The dialogs in the procedure described below will vary with operating system; these dialogs reflect the process for Windows 7 and Windows 8.
Windows 7/8
From Control Panel, choose Network and Sharing Centre and click Local Area Connection:

The local area connection status is displayed – choose Properties:

Choose the IP Protocol Version 4 and click Properties:
Specify the IP Address and subnet mask as assigned by the network administrator – the most important settings are shown below as an example; other settings should be filled in as assigned by the administrator.

Note that the IP address and subnet masks should relate to those of the TDR.

*Note: it may also be necessary to alter the settings of the Windows firewall to allow communication between the host PC and the DSA8300.*
2-9 Configuring Atlas

To apply the network settings, start Atlas and from the Utilities menu choose Config...and the General tab:

Ensure Enable Demonstration Mode is unchecked. Select the TDR tab:

Atlas is shipped with the TDR IP address set to 0.0.0.0; this must be changed to the actual address of the TDR. (The IP address of the TDR may be confirmed from its network settings dialogs as shown above.) Enter the IP address of the TDR assigned by the network administrator. It will look like 10.0.0.17 (or 192.168.0.8 or similar.)

2-10 Updating the TekVISA Instrument List

When both addresses have been assigned, start the TekVISA Resource Manager and Update the Instrument List. You should see the TDR reporting its IP address as shown below.
To verify the connection, using the Atlas software, start Atlas, create and run a sample test and check Atlas returns data.

2-11 Running the program

To start the Atlas program, double click the Atlas icon with the mouse or highlight the icon and press <Enter>.

After a few seconds the main Atlas display will appear.

*Hint:* The Atlas program may be started each time Windows is started — hold the <Ctrl> key depressed and drag the Atlas icon with the mouse to copy it to the **Startup** group.

2-12 System configuration

The system configuration *(Utilities|Config)* dialog allows the operator to specify the Atlas operating environment. Options can be changed at any time during normal operation.

From the **Utilities** menu select **Config...** to display the **Config** dialog box. Select the **General** tab:

To exit any of the **System Configuration** menus without recording any changes press <Esc> or click the **Cancel** button.

![System Configuration](image)

- **Show All Menu Options**
- **Enable Demonstration Mode**
- **Results to Right of Waveform**

**Passwords**
- **Operator**
- **Administrator**
- **Enable password on Exit**

**Display Cursor**
- **None**
- **Horizontal**
- **Vertical**
- **Both**

**Edit Default Test**
- **SET25IL**
- **Impedance**
- **SFP**
- **Delta-L**

**OK**  **Cancel**
General options

Show All Menu Options
Use Show All Menu Options to display full (all commands) or partial menus.

Enable Demonstration Mode

Enable Demonstration mode is provided to allow the Atlas program to be operated without an instrument connected. In this mode when the Test function is selected Atlas allows the operator to select a stored waveform for display.

Results to Right of Waveform

The results table may be displayed to the left or right of the waveform in the results screen, Check the box as appropriate.

Choosing display cursors

Atlas provides on screen cursors for precision measurement of waveform values – choose horizontal, vertical or both.

System security

Atlas incorporates two levels of security, Administrator and Operator. The Passwords options enable the Administrator to specify password protection for critical system (e.g. Configuration and diagnostics) information and test files.

Specifying a password

Specifying a password is optional; if an Administrator password is specified, unauthorised users will be prevented from modifying the system configuration, editing test files (files containing test parameters) or deleting logged records. If a password is set it will be requested before these operations are permitted. If an Operator password is set it will be required if an operator attempts to alter test parameters. All system changes will require the Administrator password. To specify a password, activate the Password box and type the password — up to 8 characters may be used. For security, characters typed will be displayed as asterisks. If no password is required leave the field blank. Re-type the password in the confirmation box to verify the original.

Activate on Exit

If a password has been specified, exiting this screen with this box checked enables password protection immediately; otherwise the password protection is not enabled until the software is next run.
Controlling test file editing permissions

With an Administrator password specified Atlas will require the Administrator password to access the Test File Editor to alter test parameters for a test or group of tests. If an operator password has been specified the Administrator is able to grant controlled operator access to the Test File Editor.

Edit Default Test

Default test parameters can be specified for both loss and impedance tests. Click SET2DIL, Impedance, SPP or Delta-L to display the associated test editor and set parameters; these parameters will be predefined when creating new tests.

TDR options

The TDR options define the TDR measurement system and its IP address – see Configuring Atlas.

Colours

Click the Colours tab to define and save colour schemes for the Atlas screen components, waveform, text, background, etc. Click on a component in the list and then click Edit to change its colour.

Datalog and Snapshot settings

Use the datalog options to define the Station ID, the paths to the datalog and snapshot files (the default location is the same folder as the test file folder) and up to three user defined datalog columns.
Prompts

Confirmations

Use the Prompts dialog to require confirmation for deleting tests and clearing waveforms.

Auto Advance options

Atlas can be set to auto-advance through tests when data logging (Auto Advance from the Datalog menu); use the Display Last Waveform before Auto Advance to display the test result momentarily before moving on to the next test – specify the delay time between tests in seconds.
**Displaying license information**

Click the FlexLm tab to display the current license information. The dialog shows the features claimed and available on the installed license.

The FlexLm Path option displays the path to the license file.

**Displaying cautions**

Click the Cautions tab to select which cautions are displayed – double click each caution to enable or disable it.
Specifying Loss options
Select the Loss tab to specify the notifications and SET2DIL Intel target file path.

Exporting Intel SET2DIL files
Atlas can export SET2DIL files for later processing. Use the default path or define a suitable folder for SET2DIL file storage.
SECTION 3 — GETTING STARTED

FIRST TIME ATLAS OPERATION

IMPORTANT The Atlas compatible measurement system (TDR) is an extremely sensitive measuring instrument. To prevent damage to the TDR, observe static precautions at all times. See Appendix A for information.

3-1 The Atlas screen

The Atlas screen window is split into three window panes and comprises six sections:

- The Test List window pane which lists the tests within the active test file.
- The Waveform Display window pane which displays the loss or impedance waveform and test results.
- The Datalog Results window pane displaying logged test results (e.g. for a batch of boards using the active test file).
- The Menu bar containing the Atlas commands
- The Tool bar, which provides short cut access to the most commonly used commands.
- The Status bar, which displays test and data logging information and descriptions of the Tool bar buttons as the mouse is moved over each button.

The Atlas window may be increased or decreased in size by dragging the window borders with the mouse.

If necessary, press the Maximise button to increase the display size to full screen.

3-2 The Atlas tool bar

The Atlas tool bar (described in detail in the next section) contains buttons that provide quick mouse access to the most frequently used Atlas commands:

(In this Getting Started section only the File Open and Execute Test buttons are used.)
The **File Open** button displays the **Open** dialog box and allows the user to choose a test file. Each test file contains one or more tests for the board under test.

The **Execute Test** button performs a test using the selected test list item.

### 3-3 Demonstration Mode

**Demonstration Mode** is provided to allow Atlas to be operated without a compatible measurement instrument connected.

In this mode when the Test function is selected Atlas allows the operator to select a stored waveform for display to simulate test results. Atlas is set to Demonstration Mode by default.

**Using demonstration mode**

Switch between Demonstration Mode and Live mode via Tools|Config|General|Enable Demonstration Mode. In this Getting Started section Demonstration Mode is selected.

**Adding a test to the Test List**

Tests are grouped into test files; typically a coupon under test will include several tests for both impedance and loss saved in a single test (.atlas) file.

To add a new test press the INS key and choose a Loss or Impedance test. In this example choose an Impedance test.
Impedance testing

Choosing an impedance test will display the Impedance Test dialog; type a description of the test in the Description field, layer information in the Layer field and choose a Single Ended test using Channel 1. For this example we specify a test impedance value of 50 Ohms.

**Horizontal display units**

The Impedance test dialog allows for horizontal display units of time (seconds, nanoseconds or picoseconds) or distance (meters, millimetres, feet or inches). These units will be used for the Test From, Test To and Start Display at fields; all measurements are relative to the end of the probe.

**Vertical display units**

Vertical units may be specified in Ohms, Rho or milliRho. Choose Ohms.

**Tolerance**

Plus and minus tolerances may be locked (e.g. ±5%) or set independently and specified in % or Ohms. Leave the Tolerance setting at 5% locked.

**Test From and Test To**

Use the Test From and Test To fields to specify the length of trace or time period to be tested. In this test change units to nanoseconds and measure between 1 and 2 nanoseconds.

Click OK to confirm values and close the dialog. The test is added to the Test List.
Executing an impedance test
Select the test from the Test List and click the Test button; with Atlas in Demonstration Mode choose one of the supplied demonstration files for display. Three single ended test waveforms are included, 28 Ohms, 50 Ohms and 75 Ohms.

For this example choose the Z_50_Ohm.txt file; the waveform is displayed on screen.

PASS/FAIL results are shown on screen along with values at the cursor crosshair point. Use the mouse to move the cursor.

Use the Shift & arrow keys to pan the display around the view screen; use the Shift & +/- keys (vertical) and Ctrl & +/- (horizontal) keys to zoom in and out of the display.
**Editing the test file**
To edit the test parameters, for example to modify the Test From and Test To values, right click the test in the Test List and choose Edit...; the Test dialog is displayed; modify the values as required, close the dialog and re-run the test. For this example open the Test Editor and modify the impedance value and run the test for 28 Ohms. Repeat the test for 75 Ohms between 0.3 and 1.3nS.

**Displaying the impedance statistics**
Atlas displays the PASS/FAIL result for the test and displays the impedance statistics over the tested area:
- average impedance
- maximum impedance
- minimum impedance

The tested area is usually the flattest portion of the coupon waveform and is usually referred to as the *undisturbed interval* (ignore test connection aberrations and open circuit termination effects).

Values are presented in the associated boxes on screen along with the impedance waveform. If the displayed waveform extends outside the limit lines Atlas records a **FAIL**.

(If Atlas records a **FAIL** on the coupon, check for good contact between the probe and the trace on the coupon and try again.)

**Loss testing**
Atlas uses the Delta-L, SPP (Short Pulse Propagation), Bidirectional SET2DIL (Single Ended TDR to Differential Insertion Loss) and SET2SEIL (Single Ended TDR to Single Ended Insertion Loss) methods for loss modelling.

Impedance and loss tests may be combined in a single test file. To insert a loss test press the INS key and from the short cut menu choose either a Delta-L, SPP, SET2DIL (loss) test. To minimise probe movement, group impedance and lost tests for each trace. This example discusses the SET2DIL test method.

**SET2DIL tests**
Press the INS key to insert a new test and choose a SET2DIL (loss) test:
The Test Editor dialog is displayed: Use the Loss Test Editor
dialog to enter the test description and Bidirectional SET2DIL
test parameters.

Specifying the Configuration
Choose SET2DIL as Configuration and specify Microstrip
and tick the BiDirectional check box.

Channel Selection
The SET2DIL test is a two channel test so tick Channels 1
and 2 check boxes.

Note: the probe must be connected, via the Atlas 800 ESD
Protection Module, to both channels of the same plug-in
sampling module.
Choosing the number of averages
For this example leave the number of averages at 256.

Choosing the number of data points
For this example leave the number of data points at 4000

Reference line lengths
The default reference line lengths for a SET2DIL test are 0 in. for the Short parameter and 8 in. for the Long line; for this example leave Short at 0 and Long at 8. These settings are normally set to the actual reference and test trace lengths.

Setting test limits
Check the Evaluate against Line Fit option and choose a Linear fit. Use the Test Limits controls to specify the loss limits in dBs at designated frequencies.

To set a new limit, enter the frequency value (4 GHz in the example screen above) and the maximum loss allowable at that frequency (0.8dB in the example) and click Add New. Enter a new Frequency GHz of 8GHz and a Max dB Loss of 1.6dB and click the Add New button.

The example screen above shows 2 maximum loss limits defined. Click OK to confirm and close the dialog. The loss test is added to the Test List.

Leave the Calculate/Display Loss per 1.00 Inches and the Short and Long line lengths at the default settings; Atlas will calculate and display the loss/inch over an 8 inch line.

Running the test
Select the test from the test list.
Click the Test button and from the Navigate to File dialog choose the BiDirSet2DilMicrostrip.txt file:

```
<table>
<thead>
<tr>
<th>Name</th>
<th>Date modified</th>
<th>Type</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>BiDirSet2DilMicrostrip.txt</td>
<td>19/06/2013 08:25</td>
<td>Text Document</td>
<td>860 KB</td>
</tr>
<tr>
<td>BiDirSet2DilStripline.txt</td>
<td>19/06/2013 08:25</td>
<td>Text Document</td>
<td>860 KB</td>
</tr>
<tr>
<td>BiDirWellBehaved.snapshot</td>
<td>18/06/2013 12:35</td>
<td>SNAPSHOT File</td>
<td>503 KB</td>
</tr>
<tr>
<td>yssver.scc</td>
<td>25/06/2013 16:04</td>
<td>SCC File</td>
<td>1 KB</td>
</tr>
<tr>
<td>Z_28_Ohm.txt</td>
<td>18/03/2013 11:04</td>
<td>Text Document</td>
<td>53 KB</td>
</tr>
<tr>
<td>Z_50_Ohm.txt</td>
<td>18/03/2013 11:04</td>
<td>Text Document</td>
<td>52 KB</td>
</tr>
<tr>
<td>Z_75_Ohm.txt</td>
<td>18/03/2013 11:04</td>
<td>Text Document</td>
<td>52 KB</td>
</tr>
<tr>
<td>Z_Beatty_line.txt</td>
<td>18/03/2013 11:04</td>
<td>Text Document</td>
<td>52 KB</td>
</tr>
</tbody>
</table>
```

Click Open.
Atlas displays the stored waveform as shown below:

In the sample waveform above Atlas graphs dB loss per inch against frequency; the loss at each specified frequency (shown at right) is within the limits so Atlas records a Pass.

Losses within the system bandwidth are shown in green with the line fit within the specified frequency range in red. The extrapolated line is shown in blue. Colours may be set by the user if using user-defined colour schemes so may differ from the above graphic.

Repeat the procedure for a stripline configuration using the BiDirSet2DilStripline.txt file.

3-4 Exiting the program

Select Exit from the File menu or press Alt+F4 to leave the program.
SECTION 4 — SYSTEM OPERATION

USING ATLAS

IMPORTANT The Atlas compatible measurement system (TDR) is an extremely sensitive measuring instrument. To prevent damage to the TDR observe static precautions at all times. See Appendix A for information.

4-1 Starting ATLAS

Note: These operating instructions assume that the installation procedure has been successfully completed and the host PC, Atlas 800 and TDR are communicating successfully.

Double clicking the Atlas icon starts the Atlas program. When the Atlas program runs, the main Atlas screen is displayed loaded with the last test file used. Figure 4-1 shows the Atlas main screen:

![Atlas main screen](image)

Figure 4-1 Atlas main screen

4-2 The Atlas screen

The Atlas window is split into three main areas:
Test List window
The Test List window pane contains each named test within the currently selected test file.

<table>
<thead>
<tr>
<th>Description</th>
<th>Layer</th>
<th>Test</th>
<th>Loss, Build</th>
</tr>
</thead>
<tbody>
<tr>
<td>Impedance</td>
<td>L4</td>
<td>Impedance</td>
<td></td>
</tr>
<tr>
<td>SET2DIL</td>
<td>L1</td>
<td>Loss</td>
<td>Microstrip</td>
</tr>
<tr>
<td>SET2DIL</td>
<td>L4</td>
<td>Loss</td>
<td>Stripline</td>
</tr>
</tbody>
</table>

"End"

Waveform Display window
The Waveform Display window pane displays the loss v frequency waveform or the impedance v time or distance waveform and statistical results for the selected test.

The Waveform Display window reflects the type of SET2DIL test, Bidirectional or Unidirectional.
Datalog Results Window

The Datalog Results window pane displays the logged results for one or more boards using the current test file.

| Serial | Test   | Description | Layer | Result | Loss ft 1 | Loss ft 2 | Loss ft 3 | Loss ft 4 | Loss ft 5 | Loss ft 6 | Loss ft 7 | Loss ft 8 | Loss ft 9 | Loss ft 10 | Loss ft 11 | Loss ft 12 | Loss ft 13 | Loss ft 14 |
|--------|--------|-------------|-------|--------|-----------|-----------|-----------|-----------|-----------|-----------|-----------|-----------|-----------|-----------|-----------|-----------|-----------|
|        |        |             |       |        | 0.000     | 0.000     | 0.000     | 0.000     | 0.000     | 0.000     | 0.000     | 0.000     | 0.000     | 0.000     | 0.000     | 0.000     | 0.000     | 0.000     |

Atlas includes two control sections:

- The menu bar containing the Atlas commands
  - The tool bar which provides short cut access to the most commonly uses commands.
  - The status bar displays descriptions of the tool bar buttons as the mouse is moved over each button, menu command information as the mouse is moved over each menu item in an open menu and test and data logging information.
- The Atlas window may be increased or decreased in size by dragging the window borders with the mouse.
- The main screen window can be maximised to full screen view if desired — click the Maximise button (or double-click the Atlas title bar or press Alt+Spacebar then X on the keyboard).

4-3 The Atlas menu bar

All Atlas commands are available from pull-down menus; commands can be accessed via the keyboard or mouse (see OPERATING ATLAS.)

The File menu

Use the File menu to process Atlas test files.
Employ these menu commands to:

- Create new test files
- Open and save existing files
- Save test and waveform data (Snapshot files)
- Exit from the Atlas program (Atlas will prompt to save a test file if changes have been made)

When the **File** menu appears the last test files opened are listed in reverse order.

**The Board menu**

The Board menu contains the commands to clear the currently stored waveforms from the test window, insert new tests into a test file, modify existing board test parameters within the current test file and export waveforms.

---

**Creating and editing board tests**

Use the **Insert Test...** command (or press the Insert key) to add a controlled impedance trace test to a board test file: the Test Editor is displayed to allow test parameters to be specified for the new test (see **Test Editor**). The **Edit...** command allows changes to be made to existing tests.

The **Delete** command removes the test from the test list; choose **Test** to run the test on the trace.

**Exporting Atlas waveforms**

Atlas waveforms may be exported in text format for later analysis; choose the test from the test list then select the **Export Waveform** command and specify the file name and destination.
Export Waveform
Each waveform is exported under its test name as a separate text file in the destination folder.

Board information
Typically, each board will have an associated test file containing all the tests for the traces on the board. Each board test file will include board setup information.

Use the Clear All Waveforms commands to remove all test result waveforms from the test window.

The Datalog menu
The Datalog menu allows the user to control the Atlas data logging facilities. Data logging enables test data to be automatically logged to a text file for archiving and subsequent analysis. The log file can be printed out or imported into a spread sheet for analysis.

Automatic data logging can be toggled on or off via the Autolog command. Autolog is ON by default and its status is saved between sessions.

Tests may be cycled through in sequence automatically or manually selected. If Auto Advance is selected Atlas steps through the test list from the top depending on the Auto Advance option specified (Off, On Pass, After Test).

Begin data logging with the Datalog Now... command.

Datalog results can be exported in CSV format. Choose Export Datalog as CSV to export the contents of the Datalog window. Choose the SPP or SET2DIL options to export their results respectively.
The View menu

The View menu allows the user to control the display of Atlas screen items (toolbar, status bar), test list and datalog readings and waveforms.

Click the Toolbar and Status Bar items to toggle each item on or off.

Displaying statistical data

Click the Select Testlist Columns to choose statistical information for display in the Test List.
Click each item in the Available column and click Add to include it in the Test List display; items can be reordered using the Move Up and Move Down buttons or removed from display.

Click Select Datalog Columns… to choose statistical information for display in the Datalog window pane.

Move items between the available and selected panes as described above for the Test list.

**Display Data Points**

Choose Display Data Points to highlight all the data in bold.

**Display Source Waveforms**

Use the Display Source Waveforms commend to toggle between all SPP waveforms in reduced view and the selected waveform in detailed (magnified) view.

**Display Result Table**

Use the Display Result Table to toggle the table of results on or off. The table can be shown to the right or left of the graphical display.

**Display Cursor Readout**

Atlas provides horizontal and vertical cursors for precision measurements of on-screen waveforms. Choose horizontal, vertical or both. Cursor readout values can be shown on the left or right of the graphical display.
The Utilities menu

Users can change operating conditions during normal Atlas operation via the **Utilities** menu.

![Utilities menu]

**Config…**

Use the **Config** command to change System Configuration options (see **SYSTEM CONFIGURATION** for more details).

**Diagnostics**

It is recommended that the diagnostics functions be performed only by qualified Polar service personnel.

**Locate EOP and Align Pulser / Sampler…**

Use Locate EOP to characterise the probe/cable system. See **End of Probe (EOP) calibration** for details.

**Erase Thru Waveform (SET2DIL)**

Use this command at the beginning of a coupon test to force a re-acquire of the Thru reference waveform. When a test is next run, Atlas will prompt for the Thru reference waveform for the coupon.

**SET2DIL Deskew**

See **SET2DIL tests** for a discussion of the SET2DIL deskew procedure.

**Export Intel SET2DIL File sets**

Waveform data from an Intel SET2DIL test may be exported in a format suitable for processing by the Intel SET2DIL script.

Click **Export Intel SET2DIL (.csv) File set**.

Navigate to a suitable folder and specify a descriptive file name.

Intel SET2DIL file sets are exported as Q1, Q2, and Thru file sets in comma separated format (.csv). Bidirectional tests include Q1, Q2 and Thru files for each direction.
Each SET2DIL file set is exported under its test name as a group of separate text files in the destination folder.

<table>
<thead>
<tr>
<th>Name</th>
<th>Date modified</th>
<th>Size</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>MS_85_Dir12_Q1.csv</td>
<td>02/07/2013 15:08</td>
<td>118 KB</td>
<td>Microsoft Excel Comma Separated Values File</td>
</tr>
<tr>
<td>MS_85_Dir12_Q2.csv</td>
<td>02/07/2013 15:08</td>
<td>118 KB</td>
<td>Microsoft Excel Comma Separated Values File</td>
</tr>
<tr>
<td>MS_85_Dir12_Thru.csv</td>
<td>02/07/2013 15:08</td>
<td>118 KB</td>
<td>Microsoft Excel Comma Separated Values File</td>
</tr>
<tr>
<td>MS_85_Dir21_Q1.csv</td>
<td>02/07/2013 15:08</td>
<td>118 KB</td>
<td>Microsoft Excel Comma Separated Values File</td>
</tr>
<tr>
<td>MS_85_Dir21_Q2.csv</td>
<td>02/07/2013 15:08</td>
<td>119 KB</td>
<td>Microsoft Excel Comma Separated Values File</td>
</tr>
<tr>
<td>MS_85_Dir21_Thru.csv</td>
<td>02/07/2013 15:08</td>
<td>118 KB</td>
<td>Microsoft Excel Comma Separated Values File</td>
</tr>
</tbody>
</table>

The Help menu

Select About Atlas... for product and firmware versions and licensing information.
4-4 The Atlas tool bar

The Atlas toolbar contains buttons that provide access to some of the most frequently used Atlas commands:

- **File New** button to create a new test file.
- **File Open...** press this button to display the **Select Test File** dialog box and choose a test file.
- **File Save** — save the current test file.
- **Board Edit** — starts the Test File Editor
- **Execute Test** — perform a test using the selected test file.
- **Locate EOP** — characterise the probe and measurement system and deskew channels
- **Caution List** — display current Caution item list
- **Erase Thru Waveform** — Erase reference / Thru waveform
- **Export CSV** — export contents of datalog window in CSV format
- **Help About** — display version/licensing details
4-5 The Waveform Display window pane

Impedance tests

When an impedance test is executed Atlas displays the resulting impedance waveform along with the test limits (the limit lines), and the results of the test in the Waveform Display window pane.

The PASS/FAIL result and the statistical data for the tested region of the displayed waveform (between the two limit lines) are included in the statistics/results area — the upper left corner of the Waveform Display window pane. The tested region is commonly referred to as the undisturbed interval or flattest portion (ignore test connection aberrations and open circuit termination effects) of the waveform and delimited by the width of the test limits (between the limit lines — shown above). On completion of a test the resulting test waveform is displayed, a PASS or FAIL is reported and displayed statistical data is updated. Use the cursors to examine waveform point values.

Displaying the impedance statistics

Atlas displays the PASS/FAIL result for the test and displays the impedance statistics over the tested area:
- average impedance
- maximum impedance
- minimum impedance

Values are presented on screen along with the impedance waveform. If the displayed waveform extends outside the
limit lines Atlas records a **FAIL**. (If Atlas records a **FAIL** on the coupon, check for good contact between the probe and the trace on the coupon and try again.)

### SET2DIL Loss tests

When a SET2DIL loss test is executed Atlas uses the Bidirectional SET2DIL (Single-Ended TDR to Differential Insertion Loss) method to display the resulting loss per unit length v frequency waveform along with the test results table at each user-specified frequency in the Waveform Display window pane.

**PASS** loss/frequency data points in the results table are printed in green, **FAIL** points are printed in red. The graph above displays differential insertion loss, $S_{DD21}$, against frequency over the range of the measurement/probe system.

Atlas monitors system rise time and the available system bandwidth and charts loss data points within the system bandwidth in green – data points beyond the system bandwidth are plotted in red. The fitted line is shown in red; test results are evaluated against the fitted line. Extrapolated data are shown in blue. (Colours may be changed via Utilities|Config…)

The vertical axis charts loss in dB per unit length – using the integrated test editor the scale may be selected in metric or US units and customised to suit the application.

Atlas allows impedance and differential frequency-dependent loss tests to be included within a single test file, providing comprehensive board characterization in the GHz region.
**SPP tests**

When a SPP loss test is executed Atlas uses the Short Pulse Propagation method to display a set of impedance and loss tests including even and odd mode impedances, attenuation, phase and Effective Er per unit length v frequency waveform along with the test results tables at each user-specified frequency in the Waveform Display window pane.

PASS loss/frequency data points in the results table are printed in green, FAIL points are printed in red. The graph above displays Alpha, attenuation, against frequency over the range of the measurement/probe system.

Other tests include Pre-screen Impedance, odd mode, even mode, single ended impedance in the forward and backward directions, TDT and windowed impulse response waveforms, short and long line spectra and Effective Er v frequency.

**Impulse forming networks**

SPP tests use *impulse forming networks* to produce the narrow pulses required for the test. These consist of simple passive differentiator networks placed in-line with the source cable injecting the signal into the test coupon.

Atlas includes as a purchasable option impulse forming networks implemented in software. The impulse forming network type is selected via the SPP test editor.

**Delta-L tests**

When a Delta-L loss test is executed Atlas uses the Delta-L method to display a set of loss tests including $S_{dd21}$, phase and Effective Er per unit length v frequency waveform along with the test results tables at each user-specified frequency in the Waveform Display window pane.
The summary screen contains thumbnails of the Raw TDT waveforms, the results for SDD21, the short and long line spectra and the phase and effective Er over the test frequency range. Click on each thumbnail to view the waveform in detail.

PASS loss/frequency data points in the results table are printed in green, FAIL points are printed in red. The graph above displays \( S_{DD21} \) against frequency over the range of the measurement/probe system.

**The Waveform Display shortcut menu**

Right-clicking into the Waveform Display window pane displays the Waveform Display shortcut menu:

- Display Data Points
- Display Source Waveforms
- Log Frequency Scale
- Display Result Table
- Display Cursor Readout
- Export Waveform

The shortcut menu contains the most commonly used functions for waveform display.

*Display Data Points*

Use the Display Data Points command to display all sampled data in a waveform.
Display Source Waveforms

The Display Source Waveforms command toggles the display between thumbnail views of all tests and detailed view of a selected test. Clicking on a test in the

The loss source waveforms can be displayed for diagnostics purposes within the context of the SET2DIL method.

Export waveform

Select Export waveform to save the waveform data in space-delimited format for analysis in a spreadsheet or database.

4-6 The Test List

The Test List is displayed in the Test List window pane.

The List contains one or more columns, or fields, displaying information (for example, the description, test parameters or test results, if any) for each test in the active test file. Descriptive and parameter information is derived from the entries and settings in the Test Setup Editor window. By default the Description (i.e. the test name) and the Average impedance result are displayed.

Test results include a PASS/FAIL result along with statistical information for the test. The Description field displays a PASS result as a green tick or a FAIL with a red cross.

Adding columns to the Test List

To add fields to the Test List right click into the Test List window pane — the Test List short cut menu is displayed:

Choose the Select Columns… command to display the Select Test List Display Columns dialog box.
The Select Test List Display Columns dialog box comprises two list boxes — the box on the left lists the fields which are still available for inclusion in the Test List pane, the box on the right lists the currently displayed fields.

![Select Testlist Columns dialog box](image)

Fig 4-3 Adding and removing fields with the Select Testlist Columns dialog box

To add a column, select the field from the list of available fields and click the Add button; to remove a column, select the field from the list of displayed fields and click the Remove button.

To select a group of adjacent fields drag the mouse over the range of fields; to select non-adjacent fields, hold the Ctrl key down while clicking on the fields of interest — press OK to confirm the selection.

Pressing the Default button restores the displayed fields to the default fields.

### 4-7 The Datalog

Test results are recorded in the Datalog window pane.

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Layer</th>
<th>Result</th>
<th>ZAvg</th>
<th>Loss</th>
<th>Log Fit</th>
<th>Data Points</th>
<th>Loss Ref</th>
<th>Loss RH</th>
<th>Loss BR</th>
<th>Loss Build</th>
<th>Loss Dts</th>
<th>Loss R2</th>
<th>Loss YIntercept</th>
<th>ESP TP Window</th>
<th>Loss Metric</th>
</tr>
</thead>
<tbody>
<tr>
<td>Impedance</td>
<td>Z_MG_1</td>
<td>L1</td>
<td>Pass</td>
<td>0.19</td>
<td>1.284</td>
<td>Linear</td>
<td>4000</td>
<td>-0.619</td>
<td>-1.086</td>
<td>Microstrip SET20kI, 1.125 in</td>
<td>0.0506</td>
<td>0.0512</td>
<td>-450/0°/12 x</td>
<td>Inches</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Loss</td>
<td>MG_RL_Div 1</td>
<td>L1</td>
<td>Pass</td>
<td>0.793</td>
<td>1.218</td>
<td>Linear</td>
<td>4000</td>
<td>-0.629</td>
<td>-1.270</td>
<td>Spline SET20kI, 1.125 in</td>
<td>0.084</td>
<td>0.082</td>
<td>-450/0°/12 x</td>
<td>Inches</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Impedance</td>
<td>Z_SL_1</td>
<td>L4</td>
<td>Pass</td>
<td>0.793</td>
<td>1.218</td>
<td>Linear</td>
<td>4000</td>
<td>-0.629</td>
<td>-1.270</td>
<td>Spline SET20kI, 1.125 in</td>
<td>0.084</td>
<td>0.082</td>
<td>-450/0°/12 x</td>
<td>Inches</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Loss</td>
<td>MG_RL_Div 2</td>
<td>L4</td>
<td>Pass</td>
<td>0.793</td>
<td>1.218</td>
<td>Linear</td>
<td>4000</td>
<td>-0.629</td>
<td>-1.270</td>
<td>Spline SET20kI, 1.125 in</td>
<td>0.084</td>
<td>0.082</td>
<td>-450/0°/12 x</td>
<td>Inches</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Impedance</td>
<td>Z_SL_2</td>
<td>L4</td>
<td>Pass</td>
<td>0.793</td>
<td>1.218</td>
<td>Linear</td>
<td>4000</td>
<td>-0.629</td>
<td>-1.270</td>
<td>Spline SET20kI, 1.125 in</td>
<td>0.084</td>
<td>0.082</td>
<td>-450/0°/12 x</td>
<td>Inches</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Loss</td>
<td>SL_RL_Div 1</td>
<td>L4</td>
<td>Pass</td>
<td>0.793</td>
<td>1.218</td>
<td>Linear</td>
<td>4000</td>
<td>-0.629</td>
<td>-1.270</td>
<td>Spline SET20kI, 1.125 in</td>
<td>0.084</td>
<td>0.082</td>
<td>-450/0°/12 x</td>
<td>Inches</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Impedance</td>
<td>Z_MG_2</td>
<td>L1</td>
<td>Pass</td>
<td>0.793</td>
<td>1.218</td>
<td>Linear</td>
<td>4000</td>
<td>-0.629</td>
<td>-1.270</td>
<td>Spline SET20kI, 1.125 in</td>
<td>0.084</td>
<td>0.082</td>
<td>-450/0°/12 x</td>
<td>Inches</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Loss</td>
<td>MG_RL_Div 3</td>
<td>L1</td>
<td>Pass</td>
<td>0.793</td>
<td>1.218</td>
<td>Linear</td>
<td>4000</td>
<td>-0.629</td>
<td>-1.270</td>
<td>Spline SET20kI, 1.125 in</td>
<td>0.084</td>
<td>0.082</td>
<td>-450/0°/12 x</td>
<td>Inches</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Impedance</td>
<td>Z_SL_3</td>
<td>L4</td>
<td>Pass</td>
<td>0.793</td>
<td>1.218</td>
<td>Linear</td>
<td>4000</td>
<td>-0.629</td>
<td>-1.270</td>
<td>Spline SET20kI, 1.125 in</td>
<td>0.084</td>
<td>0.082</td>
<td>-450/0°/12 x</td>
<td>Inches</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Loss</td>
<td>SL_RL_Div 2</td>
<td>L4</td>
<td>Pass</td>
<td>0.793</td>
<td>1.218</td>
<td>Linear</td>
<td>4000</td>
<td>-0.629</td>
<td>-1.270</td>
<td>Spline SET20kI, 1.125 in</td>
<td>0.084</td>
<td>0.082</td>
<td>-450/0°/12 x</td>
<td>Inches</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Impedance</td>
<td>Z_MG_3</td>
<td>L1</td>
<td>Pass</td>
<td>0.793</td>
<td>1.218</td>
<td>Linear</td>
<td>4000</td>
<td>-0.629</td>
<td>-1.270</td>
<td>Spline SET20kI, 1.125 in</td>
<td>0.084</td>
<td>0.082</td>
<td>-450/0°/12 x</td>
<td>Inches</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
With a test file loaded, as the first test is executed the test list is added to the Datalog window. As each test is executed its results are displayed in columns in the Datalog.

By default the Description, Layer, and Average columns are selected for display.

To display other result fields right click into the Datalog window pane and choose **Select Columns** — the Select Datalog Columns window is displayed:

![Select Datalog Columns](image)

Fig 4-4 Adding and removing fields with the Select Datalog Columns dialog box

Click on the field in the list of available fields and press Add to include a new column to the Datalog window pane.

If logging is turned off, each time a test is repeated the test results overwrite previous data.

A yellow circle alongside each test result signifies that the results have not been logged. Data logging is discussed in **LOGGING TEST DATA**

4-8 The Status bar

The Atlas status bar displays activity and status information and messages to assist the user during Atlas operation.

![Atlas status bar](image)

Figure 4-5 Atlas status bar

The status bar comprises four sections:
Current activity/command button – Atlas reports its current activity, Ready... etc. When the mouse is moved over a Toolbar button this portion of the Status Bar is used to display a brief description of the button function.

Test information – the currently selected test in the test list is displayed

```
Test Step 1 of 3
```

Data logging information – the number of logged items, updated as each batch of tests is completed for a board.

```
Datalog 10 Item(s)
```

Measurement system information – Atlas identifies the currently connected compatible measurement system and its address on the local network:

```
DSA8200 / DSA3300 [10.0.0.17] : ATLAS800
```

4-9 End of Probe (EOP) calibration

Many of the time and distance units used in Atlas are taken relative to the End of Probe (EOP). This enables test files to be written independently of TDR, cable and probe employed.

Integrity of the probing system is crucial to accurate and reliable measurements. In order to ensure measurement integrity it will be necessary to perform End of Probe calibration both prior to using the probe system and periodically during use.

EOP calibration will be required if, for example:

- the probe or a cable has been changed
- the cables are disconnected and reconnected
- the cables are reversed
- the probe connections have been disturbed, for instance, if the SMA connectors require retightening during use (in this case the connectors should be tightened with Polar torque wrench ACC313 calibrated to 5lb.in.)

Atlas loss waveforms demonstrating a reduced available bandwidth (the green section of the waveform) indicate the need for EOP calibration.

**Adjusting the Atlas SET2DIL deskew value**

Deskewing can be performed using outer layer structures. However, even with a perfectly deskewed system (cables,
probes, etc.) SET2DIL will need a small deskew offset due to the length of the Thru trace (1 or 2 ps: -1 or -2 steps.)

To compensate for thermal drift, variations in ambient temperature, environmental changes, etc. it is recommended that EOP calibration be performed frequently.

**SET2DIL calibration**

To perform an EOP calibration, click the Locate EOP toolbar button to open the Locate EOP calibration dialog.

**Note: Atlas will not allow two channels from different plug-in sampling modules to be selected.**

Before testing, or performing a deskew, ensure the TDR has fully warmed up. Ensure the probe is not connected to the device under test.

With the cables and probe in place, click the Atlas Locate EOP (End of Probe) button; in the Locate EOP (End of Probe) dialog select one of the active channels and click the EOP All button.

The settings will be used for subsequent tests until the EOP calibration is performed again. With the SET2DIL deskew completed, if SPP testing is not required click No at the alert box below.

The Polar probe/cable system is precision manufactured. For a correctly matched system the inter-channel skew should be no more than a few tens of picoseconds; if the skew required changes significantly from its normal reading or increases...
above 50 picoseconds the probe/cable system should be checked for damage or wear and repaired as necessary.

Locating end of probe & pulser/sampler alignment (SPP)
Prior to performing an SPP test it will be necessary to perform the Locate End of Probe and Pulser/Sampler alignment procedure.
The procedure should be carried out if any changes are made to hardware, cables etc., and at frequent intervals, at least daily (and more often if the equipment is operated in an environment where the temperature is subject to change.)

Ensure the DSA8300 is fully warmed up.
Click the Locate EOP button.

The Locate EOP (End of Probe) & Pulser / Sampler Alignment dialog is displayed.

SPP calibration
Click EOP & Align and follow the on-screen instructions. For Delta-L and SPP testing it will be necessary to connect and disconnect cables and channels in sequence.
For SPP calibration using SMA probes, use the provided SMA barrel connectors to connect channels as required.
Ensure the correct torque settings are used – use the supplied torque wrench.
**Delta-L calibration**

If available, use the Delta-L Calibration Fixture.

Click Yes at the alert box below to step through the pulser/sampler alignment.

Follow the on-screen procedure.

When using SMA probes it will be necessary to connect and disconnect cables using the supplied barrel connectors.

Ensure connectors are set to the correct torque using the supplied torque wrench.

For Litek probes locate the probes as shown below to connect channels 2-3. Use the foot pedal to step through the calibration procedure.
Move the probes to channels 2-4 and repeat the procedure.

![Connecting Channels 2-4](image)

Move the probes to channels 1-3 and 2-4 and repeat the procedure.

![Connecting Channels 1-3 2-4](image)

Confirm the pulser and sampler alignment on the DSA8300 as shown below.

4-10 Testing printed circuit boards

*Prior to testing boards ensure appropriate anti-static measures are observed.*

Atlas can perform both single-ended and differential impedance testing and loss testing. Impedance is charted over time or distance and is displayed within user defined limits; impedance range and accuracy will be determined by the Atlas compatible measurement system (TDR) in use.
**SET2DIL, SET2SEIL measurements**

For SET2DIL loss measurements Atlas charts differential insertion loss, $S_{D21}$, against frequency within a range specified by an unlimited number of user defined minimum and maximum values.

Loss is measured using the Bidirectional SET2DIL (Single-ended TDR to Differential Insertion Loss) method using industry standard SET2DIL coupons or the SET2SEIL (Single Ended TDR to Single Ended Insertion Loss).

A typical SET2DIL slimline coupon based on the GGB Picoprobe is shown below.

Coupon testing with Atlas will usually include both impedance and loss measurements for test traces.

Note: Polar recommends a simple fixture that supports the coupon by the edges and leaves air space beneath the board for location pins and no interference with microstrips on the back of the coupon.

**SPP measurements**

SPP tests include a selected set of SPP tests from the suite of tests defined by IPC-TM-650 Test Methods manual 2.5.5.12A. A typical SPP coupon with its SMA connection pads is shown below.

The coupon above incorporates both single-ended and differential stripline traces of known lengths. It will be necessary to enter the test type and trace lengths into the SPP test editor.

**Delta-L measurements**

Atlas uses the Delta-L method to display a set of loss tests including $S_{D21}$, phase and Effective Er per unit length v frequency waveform at each user-specified frequency along with the Raw TDT waveforms and the raw and fitted short and long line spectra.
Selecting a test file

Prior to testing a board or batch of boards a test file containing tests associated with the board type must be selected (or created if none exists). See SECTION 5 — Test Setup Editor for details of creating, modifying and saving test files.

Select the File menu and the Open... command — Atlas displays the Open dialog:

![Image of Open dialog]

The Open dialog opens with the list of files (identified by the .atlas extension) in the current folder displayed. (Test files may also be selected from the recently used file list from the File menu.)

If necessary, navigate to the folder containing the test file. Select the board test file by clicking the file name with the mouse (or press the <Tab> key to move into the file list field and use the cursor keys to highlight the test file;) click Open to load the file.

Atlas displays the name of the selected file in the Title Bar.

Arranging the test list

Although test traces on a coupon can usually be processed in any order, probe movement can often be minimised by arranging the test list to verify each trace with an impedance test prior to performing its loss test.

Select the test to be executed (usually the first in the list).

Locate the probe using the guides onto the board terminals or connections (be careful to maintain correct polarity of signal and ground connections).
Execute the tests via the **Board** menu or click the **Test** button (see note below).

If data logging has been turned on, when all tests for the board are completed supply board details for data logging in the Datalog Board Information dialog box.

Note: For convenience, users are recommended to use the Foot Switch to operate Atlas in a “hands-free” mode. Using the Foot Switch allows the operator to use both hands to hold the probe in proper contact with, and support, the board under test).

### 4-11 Executing impedance tests

Board testing can be performed with either third party or Polar Atlas probes. Polar produces a range of impedance and loss probes to accommodate most popular pin layouts. Using Polar probes minimises measurement errors due to mismatch between the impedance of the measurement system (50Ω) and the track under test.

Locate the probe carefully in position on the circuit board under test (or coupon). Select the **Test** function from the Board menu (or click the mouse on the **Test** button or use the Foot Switch for hands-free operation).

**Displaying test results**

When the test screen is displayed the limits of tolerance defined in the test for the tested portion of the track will be indicated by the limit lines (at installation the Atlas test window is set to its default color scheme — see the **Utilities** menu for information on changing screen colors). During a test Atlas checks that the displayed impedance waveform falls within the limits defined in the test file.
Atlas displays the average, maximum and minimum values over the test region (shown above with the horizontal units displayed as distance) and for a test within limits Atlas records a PASS. If the waveform is outside the limits at any point Atlas records a FAIL.

Right click the waveform window and use the zoom and pan controls to examine the waveform in detail.

As each group of tests is completed (i.e. when the whole board has been tested) the Board Information box is displayed so that board information may be added to the test results and logged.

*Launch point extrapolation*

Atlas supports launch point extrapolation (LPE) which uses line fitting to the TDR trace. LPE can better reflect the impedance that the signal sees as it launches into the trace.

To define LPE limits (usually mandated by the OEM) using the Impedance Test Editor, in the Launch Point Extrapolation section tick the check box for each of the LPE points required and define the target impedance, the tolerance and associated limits and the distance along the trace for each of the LPE points.
Atlas displays the slope of the trace over the test region extending the line through the extrapolation points (shown as error bars below.)

![Ohms Graph](image)

See Section 5 EDITING TEST FILES – Launch point extrapolation.

### 4-12 Executing loss tests

Loss tests on Atlas are based on the Bidirectional SET2DIL test method, SET2SEIL test method, Delta-L test method or SPP test method using the associated coupons.

**SET2DIL tests**

A series of loss tests on a SET2DIL coupon will be performed in two steps: acquisition of a short trace reference waveform (the ‘Thru’ reference) for the coupon and acquisition of (long trace) waveforms for each test trace on the coupon.

Ensure End of Probe calibration has been performed and the inter-channel skew reads within acceptable limits. To acquire
reference waveforms it will be necessary to create a sample test. See Section 5 – *EDITING TEST FILES*

**Acquiring a coupon reference waveform**

SET2DIL requires two waveforms for a test – a short trace or Thru waveform and a long trace (the DUT) waveform. To arrive at the correct deskew value for the system Atlas will acquire a good Thru reference and then test five coupons and allow the operator to use the derived deskew value.

Locate the probe on the Thru reference of the first board (the SET2DIL style Thru reference is shown below.)

![Thru reference waveform](image)

*The probe must be held securely in place and without movement for the duration of the test – if it is suspected that movement has taken place, repeat the test.*

![SET2DIL Intel Deskew - 4000 Data Points](image)

To begin testing locate the probe on the short (reference) trace. Click the Test button – during testing Atlas includes in its display window the coefficient of determination (R2) to indicate the fit between actual SDD21 and fitted SDD21 and presents guidelines for interpreting the R2 value.
Check the deskew settings reflect the desired fit and the correct TDR channels are selected and click Test – Atlas checks for successful probe contact with the Thru connection:

When a satisfactory connection is sensed Atlas prompts to begin acquisition:
Click OK – the TDR should display waveforms similar to those shown below – the waveforms must remain undisturbed for the duration of the acquisition.

If the waveforms are disturbed for any reason (e.g. if the probe is moved during the acquisition) press Esc to stop the current acquisition and begin again.

Click OK. (If Atlas senses that the Thru has not been successfully acquired it prompts to reacquire.)
With a successful Thru result Atlas prompts to continue through the five boards:

![Setup For Acquire...]

With the Thru successfully acquired move the probe to the long trace of the first board and press Test.

When a successful acquisition is complete it may be necessary to accept $R^2$ below the defined limit.

![R^2 (R Squared) is outside of limit. Loss result may not be credible. Obtain approval before accepting result. (R^2 Limit may be adjusted in Utilities\Config\Loss tab)]

Click OK to accept the result and move to the next coupon; Atlas calculates the deskew value:

![Results Table]

Results with “good” $R^2$ values are shown in green; results with $R^2$ values below the defined limit are shown in red. If a result is questionable click the coupon number in the list and run the test again.
Each waveform can be viewed for integrity and accepted or discarded as appropriate. When five satisfactory results have been obtained, Atlas calculates the deskew values for testing; click OK to accept or click the Manual option to enter other values. In cases where the values of deskew are already known (for example, from previous testing) the deskew values can be set without testing five coupons.

Atlas offers to save the waveform for the test file.

The reference waveform is stored; Atlas requests the first data waveform.
Running SET2DIL tests

Locate the probe on the test trace, when has sensed the Probe Down state press Test to acquire the test trace loss waveform.

Typical microstrip and stripline waveforms are shown below. For each test ensure the TDR waveforms are stable, without ringing or reflections and then click Test. Ensure the probe/board contact is maintained undisturbed throughout the test.

Typical microstrip TDR waveform

Typical stripline TDR waveform
The resulting loss waveform is displayed in the test window with the specified limits for loss at defined frequencies.

![Bi Directional SET2DIL](image)

The display window records the test result, Pass or Fail, a table of values of loss at the designated frequencies along with the graph and fitted line of loss over the specified frequency range. The linear fitted results are shown in green, loss results within the system bandwidth are charted in red, beyond the system bandwidth in yellow; extrapolated results are shown in blue. (Colours may be changed via the Utilities|Config…)

The results include deskew values for both directions along with the value of $R^2$ and the y-axis intercept. Pass results are displayed in the table in green and failed loss values in red. Continue through the tests until all results have been recorded.

**Erasing the Thru waveform**

(If the reference waveform proves unsatisfactory, click the Erase Thru Waveform button To Erase the Thru waveform and reacquire.)
SPP tests

SPP tests (compliant with IPC-TM-650 2.5.5.12A) comprise:

A series of thorough impedance pre-screening tests (testing for line taper and impedance imbalance). These tests are performed on both a long and short line in both forward and backward directions.

Alpha (loss) / Beta (phase) tests / calculation of effective Er.

Typical SPP coupon connectors and terminology

The board below illustrates the arrangement typical of SPP coupon layout. Connectors are surface mount SMA; each connector is fitted to the board with screws sized to the thickness of the coupon. The coupon below includes the SMA connectors for the differential SPP tests.

Atlas SPP

The following sequence steps through a typical SPP test:

Pre-screening – Waveform windowing – Alpha (loss) and Beta (phase) measurements.

The sequence below explains the coupon layout and typical connectors used.

Note: When connecting cables and hardware impulse forming networks ensure that connectors are tightened using the Polar supplied precision torque wrench set to the required torque.
Creating a new SPP test
Press the Insert key to create a new test and choose SPP.

<table>
<thead>
<tr>
<th>SET2DIL</th>
<th>Impedance</th>
<th>SPP</th>
<th>Delta-L</th>
</tr>
</thead>
</table>

Atlas displays the SPP Test Editor – see Section 5 EDITING TEST FILES for a discussion of the SPP pretest and SPP test parameters. Enter the test parameters and save the test.

Locating end of probe & pulser/sampler alignment
Prior to performing an SPP test it will be necessary to perform the Locate End of Probe and Pulser/Sampler alignment procedure.

The procedure should be carried out if any changes are made to hardware, cables etc., and at frequent intervals, at least daily (and more often if the equipment is operated in an environment where the temperature is subject to change.)

See Section 4 End of Probe (EOP) calibration
Ensure the DSA8300 is fully warmed up.

Click the Locate EOP button.

The Locate EOP (End of Probe) & Pulser / Sampler Alignment dialog is displayed.
Follow the End of Probe (EOP) calibration procedure.
Running the SPP test

Choose the test from the test list and click the Test button.

<table>
<thead>
<tr>
<th>Description</th>
<th>Layer</th>
<th>Test</th>
<th>SPP.Cfg</th>
<th>SPP.SL</th>
<th>SPP LL</th>
<th>SPP.Piz</th>
<th>SPP.FMin</th>
<th>SPP.FMax</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPP Dif</td>
<td>L4</td>
<td>SPP</td>
<td>Dif</td>
<td>40 mm</td>
<td>110 mm</td>
<td>85.00</td>
<td>0.0GHz</td>
<td>0.0GHz</td>
</tr>
<tr>
<td>SPP S/E</td>
<td>L4</td>
<td>SPP</td>
<td>S/E</td>
<td>30 mm</td>
<td>100 mm</td>
<td>50.00</td>
<td>0.0GHz</td>
<td>0.0GHz</td>
</tr>
</tbody>
</table>

Follow the on-screen prompts to step through the tests. Tests include TDR and SPP tests. The TDR tests normally precede the SPP tests, though the tests can be run in any order – as each test is completed its status is updated.

Note: the Atlas SPP prompt screens will reflect the type of test, single ended or differential, and whether hardware or software impulse forming networks have been specified.

The screens below describe the procedure for a differential test using hardware impulse forming networks.

*Pre screen impedance long line forward direction*

Connect the Ch1 and Ch2 cables to the long line forward connectors.

Click Test – Atlas performs the test and updates the test status in the dialog.
Pre screen impedance long line backward

Connect the Ch1 and Ch2 cables to the long line backward connectors.

Click Test to run the test and update the dialog.

Pre screen impedance short line forward

Move the Ch1 and Ch2 cables to the short line forward connectors.

Click Test to complete the short line forward test and update the dialog.
Pre screen impedance short line backward

Move the Ch1 and Ch2 cables to the short line backwards connectors.

![TDR SL BK](image)

Click Test to complete the pre-screen tests and update the dialog.

SPP test long line

Connect the Ch1 and Ch2 cables via the impulse forming networks (differentiators) to the start of the Differential Long Line (long line forward connectors) and Ch3 and Ch4 cables to the end of the Differential Long Line (long line backward connectors).

![SPP test long line](image)

If software impulse forming networks are used the cables are connected directly and the associated prompt screens are displayed accordingly.
Click Test to perform the SPP Long Line test

*SPP test short line*

Connect the Ch1 and Ch2 cables via the impulse forming networks (differentiators) to the start of the Differential Short Line (short line forward connectors) and Ch3 and Ch4 cables to the end of the Differential Short Line (short line backward connectors).
With all tests complete click Save & Exit.

**Reviewing test results**

The results of the SPP test are displayed as in the screen below.

Click on each waveform to display the waveform and associated readings full screen.
Using the on screen cursors

Right click the screen and choose Display Cursor Readout to allow precision measurement and readout of waveform values.
**Delta-L tests**

Delta-L tests comprise Long and Short line tests.

**Long line test**

Select the test from the test list and locate the probes on the ends of the long line – click the Test icon or use the foot pedal to step through the test.

**Short line test**

Atlas performs the long line test, displays the test status and steps through to the short line test.

Press the foot pedal to run the short line test. When the test is complete click Save and Exit.
Reviewing test results

The results of the Delta-L test are displayed as in the screen below. (The colours displayed will depend on the Utilities | Colours settings in the Config colour scheme.)

Click on each thumbnail waveform to display the waveform and associated readings full screen.

Click the full screen waveform to return to the summary screen.

*Using the result table*

The table of results may be turned on or off as necessary – right click the screen and choose Display Result Table to toggle the table on or off.
Deleting test results

From the Board menu select the Clear All Waveforms command to clear all test data from the current set of results.

*Caution: Selecting Clear All Waveforms will clear all result entries from the Test List window pane and all unlogged data from the Datalog window pane but will not remove data already logged.*

Saving test results

*Saving the results of a single test*

To save the results of a single test, from the Board menu choose Export Waveform and specify a descriptive file name.

*Saving all test results (snapshots)*

To save all results within a test file, from the File menu choose Save Snapshot File. Save snapshots in a suitable folder.

*Viewing all test results (snapshots)*

To recall a set of saved test results, choose Open from the File menu, navigate to the folder containing snapshot files and select and open the file. Atlas will load the test file with its parameters and test results. Results are then available for analysis by, for example, SET2DIL specialists.

4-13 Logging Test Data

The **Datalog** function allows the operator to test and record the results of a series of tests on a board or batch of boards. Atlas creates a log file (a text file containing test data) for archiving and subsequent analysis.

The log file is stored in delimited form (using the | character as the delimiter between fields). This format will be found suitable for import into most spread sheet or database programs — and can be printed out for hard copy.

To enable logging select the **Datalog** menu and ensure **Autolog** is turned on and select **Auto Advance** and choose **After Test** to step through the tests automatically and log results to the log file.

Select the test to be run and run the test.

**Auto Advance**

The **Auto Advance** function controls how tests in the test file are sequenced. Auto-loading is controlled using the options in the **Auto Advance** sub-menu — Off, On Pass, After Test.
If **Auto Advance** is turned **Off** Atlas will not automatically sequence through the tests. Steps in the sequence must be manually selected then run.

If **Auto Advance** is set to **After Test** Atlas will automatically sequence through the tests, regardless of test PASS/FAIL results.

When **Auto Advance** is set to **On Pass** the next test file in the sequence is loaded if the test records a PASS.

To advance to the next test in the list manually, use the mouse or the arrow keys on the keyboard.

Test the board using the associated test file; when the test is complete, the **Datalog**... board information dialog box is displayed — Figure 4-7.

(For details of creating user-defined fields, e.g. Batch, Process, etc., see SYSTEM CONFIGURATION.)

Enter the details for the board under test — serial number, date code and operator name, etc. and press **OK**.

![Datalog information dialog box](image)

Figure 4-7  Datalog information dialog box

During the data logging process log files will be saved and named using the test file name (e.g. Test MWPD1585.alog).
The Data Log window

The Data Log window displays all logged entries in the log file. Test results are stored sequentially as records in the log file.

If necessary, use the scroll bar to scroll through the list when inspecting records in the log. Each entry comprises a subset of the logged data — test name, trace layer, the result of the test, (and for impedance tests, average impedance is included by default.) In the example dialog below, Columns for Maximum impedance, Minimum impedance and Standard Deviation and other test data have been added to the Datalog window pane.

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Layer</th>
<th>Result</th>
<th>Z_Avg</th>
<th>Z_Max</th>
<th>Z_Min</th>
<th>Z_SD</th>
<th>Z_Dp</th>
<th>Z_Vp</th>
<th>ZZ</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loss</td>
<td>SET201L</td>
<td>L1</td>
<td>Pass</td>
<td>48.56 Ohm</td>
<td>48.80 Ohm</td>
<td>48.27 Ohm</td>
<td>50.13 Ohm</td>
<td>S/E</td>
<td>0.86</td>
<td>50.00</td>
</tr>
<tr>
<td>Loss</td>
<td>3 - 50 Ohm Trace</td>
<td>L1</td>
<td>Pass</td>
<td>48.58 Ohm</td>
<td>48.81 Ohm</td>
<td>48.32 Ohm</td>
<td>50.03 Ohm</td>
<td>S/E</td>
<td>0.86</td>
<td>50.00</td>
</tr>
</tbody>
</table>

To include other information such statistical data, test parameters right click into the Datalog window pane and choose Select Columns.

Choose the fields containing the statistical data or test parameters and click **Add** then **OK** — the new fields will be added to the log window.
Exporting the Datalog in CSV format
Choose the Export Datalog as CSV to export the contents of the datalog window in custom CSV format. The exported file will contain the columns selected in the datalog window.

Exporting SET2DIL data
Choose the Export SET2DIL CSV File to export the SET2DIL logged data in custom CSV format.

Exporting SPP data
Choose the Export SPP CSV File to export the SPP logged data in custom CSV format.

4-14 Exiting the Atlas program
Select Exit from the File menu to leave the Atlas program.
SECTION 5 — EDITING TEST FILES

TEST PARAMETER FILES

EDITING TEST FILES

Each board type to be tested is tested in accordance with one or more tests each of which includes a set of test parameters. Typically the set of tests for one board type will be stored in a single test file. Test files can contain tests for both loss and impedance.

5-1 The Test Setup Editor

Test parameters for boards under test may be defined or modified using the integrated Test Setup Editor. The Test Editor allows for parameter entry associated with the category of test, impedance or loss.

Impedance test parameters

The diagram below illustrates the test parameters specified in an impedance test.

![Diagram of impedance test parameters](image)

Figure 5-1 Impedance test parameters
In Figure 5-1 letters A, B, T signify the test parameters listed below:

A = Test From
B = Test To
T = Tested region (B – A)

Figure 5-2 Loss test parameters

5-2 Creating and modifying test files

Creating a new test file
To create a new test file choose the New command from the File menu. This will create a new test file called Untitled.

Atlas creates the new (empty) file; tests are added to the file via the Insert command.

Inserting tests
Select the Insert command from the Board menu (or press the Insert key) then choose SET2DL, Impedance, SPP or Delta-L as required; the associated Test Editor dialog is displayed:
5.3 Inserting Impedance tests

The Test Editor allows for parameter entry associated with the category of test, impedance or loss.

Each parameter is defined and displayed in a parameter field. To create or edit a test, modify the test parameters as required and then click OK to confirm the field edits.

The fields are described in the following sections.
**Impedance test parameters**

Entries in the fields contained in the Test Setup Editor will be available for display in the Test List and Datalog and printed out with the test results.

*Description*

Enter the test type into the Description field (e.g. D-1, 50 Ohm Trace, etc.) The Description is included as part of the data for a board.

*Layer*

Use the Layer field to indicate the trace layer (e.g. L1).

*Impedance*

Use the Impedance field to define the nominal impedance in ohms of the PCB track under test.

*Probe Channel Selection*

Use the Channel Selection function to specify the TDR channel or channels to be used for the test.

Specify any single available channel for single-ended tests. For differential tests select from available channel pairs (for example, Channels 1 & 2.) Click the Available Ch Only check box to enable only the installed TDR channel modules.

*Single-Ended Tests*

To perform a single-ended test click the Single-Ended option button and click the channel number check box.

*Differential Tests*

To perform a differential test, click the Differential option button.

In order to perform differential measurements Atlas uses Channels 1 & 2 and Channels 3 & 4, etc. as differential channels. Polar supplies a range of probes suitable for use with Atlas – contact Polar Instruments for details.

For differential testing, connect the differential probe to the selected channel pair using the supplied cables.

*Note:* It is critical for a differential test that the probe cabling for both channels is of matched impedance and length.
**Horizontal Units**

The horizontal axis on the Waveform Display screen can display either distance along the trace under test or “real (i.e. out and back) time”. Click on the drop down list box arrow to display the units available:

![Units selection](image)

The **Units** field specifies the units (time in Seconds, Nano-Seconds or Pico-Seconds or distance in Meters, Millimeters, Feet or Inches) that will be used for the Test From, Test To and Probe Length fields. It defines the units used to specify all the distance or time parameters and those used on the horizontal axis of the displayed waveform.

Note: If time units are selected the Waveform Display window displays “real time”, i.e. the “out and back” time for the TDR pulse.

**Setting Vp for distance units**

If the display units are specified in distance, Atlas enables the velocity of propagation to be defined.

Choose the distance unit and click **Edit**; Vp is set by default at 0.66, use the slider to change the value as appropriate between 0.01 and 0.99.
Start Display at
Specify the display start offset (in distance or time) from the end of the probe. This allows the user to avoid testing for impedance in an area where the displayed waveform may be ringing (e.g. where a sharp change of impedance occurs in the test system connection).

Test from
This parameter, along with the Test to parameter enables the user to specify the length of trace or propagation time to be tested.

The Test from parameter specifies the distance or time from the start of the display to the start of the length or time over which impedance is to be tested (see Figure 5-1).

It defines the start of the tested area within the display window.

Test from may be set in the range defined by the measurement system.

Test to
The Test to parameter specifies the distance or time from the start of the display to the end of the length or time over which impedance is to be tested (see Figure 5-1). It defines the end of the tested area within the display window.

It is important to set Test From and Test To to define part of the undisturbed interval in the display.

Typically this will correspond to a region as shown below. Where the waveform varies in slope it may be necessary to choose a smaller portion of the whole waveform to indicate the true impedance.
**Test to** may be set in the range defined by the measurement system.

Note that **Test to** must be greater than **Test from**.

**Vertical units**

The vertical axis on the PC screen is scaled, by default in Ohms per vertical division.

Click the dropdown arrow to select Ohms, Rho or mRho

**Tolerance**

This parameter defines the tolerance about the nominal impedance to which the track will be tested.

Plus and Minus tolerances may be locked; i.e. have the same value, or unlocked, where each value is set independently. Click the Locked check box to lock or unlock the tolerance.

The tolerance must be set to a value in the range 0.10% to 99.99% in 0.01% steps. Alternatively, it may be set directly in Ohms. Click the % or Ohms option buttons to select.

**Launch point extrapolation**

Atlas supports launch point extrapolation (LPE) which uses line fitting to the TDR trace.

To define LPE limits, click Enable for each of the points and define the target impedance for each point.

Atlas uses the values defined in the Tolerance section of the Test Editor window to set the LPE limits.
Define the distance along the trace for each of the LPE points. Atlas uses the tolerance and distance values to draw the associated error bars on screen.
5.4 Inserting SET2DIL tests

To create a new loss test choose the Insert Test… command from the Board menu and then choose Loss. This will create a new test and display the test editor.

Configuration

Atlas incorporates configuration for SET2DIL and SET2SEIL tests, both unidirectional and bidirectional, including selection of averaging, number of data points acquired and optional evaluation against a linear or root line fit.

A bidirectional SET2DIL test will include two deskew values, CH21 deskew and CH12 deskew

Specifying deskew

See Executing loss tests for a discussion of deriving the deskew value for the test
SET2DIL test parameters

Entries in the fields contained in the Test Setup Editor will be available for display in the Test List and Datalog and printed out with the test results.

Channel Selection

Select channels appropriate for the structure configuration (e.g. single channel for single-ended tests, two channels for differential tests).

Selecting the wrong number of channels for a test will produce an “Error in Channel Allocation” message.

Choosing the structure type

Choose the structure type, Stripline or Microstrip for the trace under test.

Test Description

In the Description text box supply narrative text that describes the test.

Specifying the Layer

Specify the board or coupon layer containing the test trace.

Specifying the number of averages

Choose the number of Averages for the test; lower numbers of averages will allow shorter test times, higher numbers of averaging will produce greater accuracy in readings.

<table>
<thead>
<tr>
<th>Averages</th>
</tr>
</thead>
<tbody>
<tr>
<td>512</td>
</tr>
<tr>
<td>256</td>
</tr>
<tr>
<td>128</td>
</tr>
<tr>
<td>64</td>
</tr>
<tr>
<td>32</td>
</tr>
<tr>
<td>20</td>
</tr>
</tbody>
</table>

Specifying the number of data points

Choose the number of data points for the test; Atlas will acquire 1000, 2000 or 4000 data points as required.

<table>
<thead>
<tr>
<th>Data Points</th>
</tr>
</thead>
<tbody>
<tr>
<td>4000</td>
</tr>
<tr>
<td>2000</td>
</tr>
<tr>
<td>1000</td>
</tr>
</tbody>
</table>

A Thru reference waveform will be required for each data point setting.
**Specifying trace line lengths**

SET2DIL/SET2SEIL tests consist of acquiring a reference waveform from a short ‘Thru’ reference trace, then acquiring a waveform through the trace under test and charting the difference to display just the loss in the test trace.

It is necessary therefore to specify both the length of the reference trace and the trace under test.

Enter the reference trace length in the Short text box and the test trace length in the Long text box.

Choose imperial or metric units as required and specify the loss/unit length (the default is dB/inch or dB/1000mm.) Click the Custom Length check box to change to another length.

**Setting test limits**

Click the Evaluate against Line Fit check box.

Use the Test Limits dialog to specify maximum (and optionally, minimum) values for loss at selected frequencies.
The test limits can be set to evaluate raw data, or against a linear line fit or root line fit (typically useful when conductor loss significantly predominates over dielectric loss.) The default setting for SET2DIL/SET2SEIL tests is Linear.

**Specifying a minimum limit value**

Atlas includes the option to check loss between minimum and maximum values. To include minimum values of loss for designated frequencies click the Specify Minimum check box: minimum loss values are added to the dialog.

![Test Limits dialog](image)

**Adding a new limit**

To specify a loss limit at a designated frequency enter the new frequency in GHz in the Frequency GHz text box and the new limit for loss in dB in the Max dB Loss text box and, optionally, the limit for Min dB Loss text box; click Add New.

**Modifying a limit setting**

To edit an existing setting, select the setting from the list, make the changes in the Frequency GHz and Loss text boxes and click Update.

**Deleting a limit setting**

Select the setting from the list and click Delete. With all parameters defined, click OK to close the dialog. When the test is run Atlas displays the $R^2$ and Y Axis Intercept values.
along with the raw and fitted data and the associated table of results.

![Bi Directional SET2DIL](image)

**Evaluating against a line fit**

When Evaluate against Line Fit is selected, Atlas fits a line to the measured data between 2GHz and the bandwidth of the trace under test or the user specified value. The values of the line fitted curve are then compared with the defined maximum (and, optionally, minimum) loss values at the designated frequencies. SET2DIL defaults to a Linear line fit; Root line fit will be found useful when the coupon conductor loss significantly predominates over its dielectric loss.

### 5.5 Creating and editing SPP tests

Press the Insert key to insert a new test and click SPP.

![SET2DIL Impedance SPP Delta-L](image)

The SPP test editor dialog is displayed. The SPP editor comprises two screens, the Pretest screen which includes the pre-screen impedance parameters and test limits, and
the SPP screen, containing the frequency dependent loss parameters.

**Setting the SPP pretest parameters**

**Pretest parameters**

Supply values for the Description and Layer number fields and choose the number of sample points from the Data Points drop-down.
Choosing the SPP configuration
Choose the SPP configuration (single-ended or differential.)

Prescreen single-ended impedance parameters
Specify the nominal values, tolerances and non-uniformity limits for impedance and the average impedance difference sampled over the short line test.

Prescreen differential impedance parameters
In addition to the single-ended parameters supply values, tolerances and non-uniformity settings for odd mode, even mode and single modes.

Long line regression fit
Specify the sample times and associated impedance values for the long line regression fit.

Specifying the number of averages
From the Averages drop-down choose the number of averages.

Pre screen test limits
Set the long and short line test limits – specify the test start and end points for both long and short lines. Leave the setting at Auto to enable Atlas automatically to determine suitable start and end points based on waveform data.
Setting the SPP parameters
Click the SPP tab to specify the short pulse propagation parameters. The SPP dialog screen is displayed.

Specifying the number of averages
Choose the number of Averages for the test; lower numbers of averages will allow shorter test times, higher numbers of averaging will produce greater accuracy in readings.

Specifying the impulse forming network type
Choose the impulse forming network (IFN) type, hardware pulse differentiator or its software implementation. The screen prompts during testing will reflect the IFN type.

Reference line lengths
Specify the short and long line lengths of the test coupon.

Setting test limits
Use the Test Limits dialog to specify maximum (and optionally, minimum) values for loss at selected frequencies. Five loss v frequency settings are shown in the example dialog below.
Click the Evaluate against Line Fit check box.

Specifying a minimum limit value

Atlas includes the option to check loss between minimum and maximum values. To include minimum values of loss for designated frequencies click the Specify Minimum check box: minimum loss values are added to the dialog.

Adding a new limit

To specify a loss limit at a designated frequency enter the new frequency in GHz in the Frequency GHz text box and the new limit for loss in dB in the Max dB Loss text box and, optionally, the limit for Min dB Loss text box; click Add New.

Modifying a limit setting

To edit an existing setting, select the setting from the list, make the changes in the Frequency GHz and Loss text boxes and click Update.

Deleting a limit setting

Select the setting from the list and click Delete.

With all parameters defined, click OK to close the dialog.
5-6 Creating and editing Delta-L tests

Press the Insert key to insert a new test and click Delta-L.

![Delta-L Impedance SPP Delta-L](image)

**The Delta-L test editor**
The Delta-L test editor dialog is displayed.

![Delta-L test editor dialog](image)

**Delta-L test parameters**
Entries in the fields contained in the Delta-L Test Setup Editor will be available for display in the Test List and Datalog and printed out with the test results.

*Description*

Enter the test type into the **Description** field (e.g. D-1, 50 Ohm Trace, etc.) The Description is included as part of the data for a board.
**Delta-L configuration**

Choose the Delta-L configuration (Single-ended or Differential.)

**Layer**

Use the *Layer* field to indicate the trace layer (e.g. L1).

**Data points**

Choose the number of sample points from the Data Points drop-down.

From the Averages drop-down choose the number of averages.

**Timebase and line lengths**

Use the Timebase and line lengths section to specify the waveform acquisition start point, intersample period and the lengths of the short and long lines of the test coupon.

The acquisition start point should be set to ensure both short and long line Raw TDT waveforms are contained in the waveform window and to maximise the energy displayed in the Raw TDT waveforms.
Use the acquisition start setting to shift the short and long waveforms to display maximum energy in the waveforms. See graphic below.

![Graphic showing waveforms](image)

It should normally not be necessary to alter the intersample period setting and it is recommended that it is left at its default value of 1.25pS.

Choose from imperial or metric units and the unit length over which loss will be displayed.

*Setting test limits*

Use the Test Limits dialog to specify maximum (and optionally, minimum) values for loss at selected frequencies. Click the Delta-L Iterative Fit check box and specify the minimum and maximum fit frequency limits in GHz.

*Adding a new limit*

To specify a loss limit at a designated frequency enter the new frequency in GHz in the Frequency GHz text box and the new limit for loss in dB in the Max dB Loss text box and, optionally, the limit for Min dB Loss text box; click Add New.

*Modifying a limit setting*

To edit an existing setting, select the setting from the list, make the changes in the Frequency GHz and Loss text boxes and click Update.

*Deleting a limit setting*

Select the setting from the list and click Delete.
Four loss v frequency settings are shown in the example dialog below.

![Example dialog]

**Specifying a minimum limit value**

Atlas includes the option to check loss between minimum and maximum values. To include minimum values of loss for designated frequencies click the Specify Minimum check box: minimum loss values are added to the dialog.

With all parameters defined, click OK to close the dialog.

### 5-7 Saving the test file

*Press the Save button to save the file*

When all tests for the board under test have been specified press the **Save** button, or use the **Save** or **Save As** commands from the **File** menu, to store the file as a new test file. The system will display the **Save As** dialog box to request the new file name.

**Naming test files**

Names assigned to test files must conform to the Microsoft Windows conventions for file names. File names must be unique and may contain up to 255 characters (Windows allows a total of 260 characters for the entire pathname, including the backslash characters.)
Reserved characters and names

The following characters may be used in file names:

- Letters A to Z and a to z
- Numbers 0 to 9

and the following special characters:

- ! $ % ^ & ( ) @ ~ # \ { } ` '

Operating system reserved characters such as backslashes (\), question marks (?) and asterisks (*) are not permitted in file names. Files cannot have reserved device names.

For more information on file naming conventions, consult the Windows operating system user guides.

It is recommended that users employ systematic test naming schemes in which tests are assigned descriptive names.

Saving test files under new names

To save a file under a new name select the file using the Open command from the File menu and use the Save As command to name the new file (if necessary edit the file).

5-7 Using existing files as templates

An alternative method of creating a new test file is to open an existing test file, save it under a new name and then edit it. To create a new test file, select a suitable existing file and edit the parameters for each test as required.

5-8 Printing test files

To obtain hard copy of test files (e.g. for reference or customer conformance reports) right click the Test File window pane (or select the Print command from the File menu (or press Ctrl-P)).

The Print function will print to the default Windows printer.

Click the Print Preview command to inspect the printout prior to printing.
APPENDIX A

ELECTROSTATIC DISCHARGE

PROTECTING THE TDR FROM ELECTROSTATIC DISCHARGE

Caution: The probe/input circuitry of Atlas compatible measurement systems include sensitive components that are susceptible to damage from electrostatic discharge—precautions MUST be taken to avoid static discharge into the probe.

Many of the components in modern instruments like the Atlas compatible measurement systems employ internal construction that may be damaged by electrostatic discharge (ESD). Such components are often referred to as static sensitive.

Damage caused by electrostatic discharge may be severe enough to result in the complete and instant failure of a component. Often, however, components are not destroyed but merely degraded, resulting in failure in later use or measurements becoming inaccurate.

Some devices are sensitive enough to be damaged or degraded by electrostatic discharge of only several tens of volts, voltages not uncommon at unprotected workstations.

Everyday activities such as applying tape from a dispenser, simply walking across nylon carpets or separating plastic transparency films can readily generate charges of several thousand volts.

Sources of static electricity

There are two sources of static electricity most likely to be encountered by the technician:

People (especially when wearing clothes made from synthetic fibre).

Packaging materials such as polythene bags or tubes, polystyrene containers or padding (e.g. chipples, etc.) and adhesive tape used to seal containers.
Static free workstations

Testing with Atlas and its compatible measurement systems should only be carried out at a static free workstation. The static free workstation will typically include anti-static bench mats, floor mats and wrist straps and should be kept free from materials which could generate or store a static charge.

All equipment in the workstation should be regularly checked for correct operation and grounding.

Working with Atlas

When using the Atlas compatible measurement system and probes observe the same procedures as when handling static sensitive components:

Use at an approved anti-static workstation.

Wear a wrist strap connected to the earth point on the TDR front panel.

Other protective clothing, such as conducting heel straps and metallised coats can be worn if available.

Keep materials that may produce static electricity away from the workstation.

Treat circuit boards as static sensitive components.

Avoid dragging the Atlas probes across work surfaces.

Do not point the probe at surfaces that may have a static charge, e.g. monitor screens.
APPENDIX B

ATLAS 800 ESD PROTECTION UNIT

ATLAS 800 SAFETY

Warning

The LIVE and NEUTRAL lines on this unit are BOTH fused. This unit contains no user-serviceable parts. When the unit is connected to its supply, the opening of covers or removal of panels is likely to expose dangerous voltages. To maintain operator safety, do not operate the unit unless the enclosure is complete and securely assembled.

Grounding

This unit must be earthed (grounded); do not operate the instrument with the safety earth disconnected. Ensure the instrument is connected to an outlet with an effective protective conductor terminal (earth). Do not negate this protective action by using an extension cord without a protective conductor.

Note: This instrument is fitted with 3-wire grounding type plug designed to fit only into a grounding type power outlet. If a special local plug must be fitted to the power cord ensure this operation is performed by a skilled electronics technician and that the protective ground connection is maintained. The plug that is cut off from the power cord must be safely disposed of.

Power cord color codes are as follows:

Europe
- brown = live
- blue = neutral
- green/yellow = earth (ground)

United States
- black = live
- white = neutral
- green = ground
Power supply

Check that the indicated line voltage corresponds with the local mains power supply. See the rear panel for line voltage range and frequency.

Operating the Atlas 800

This manual contains instructions and warnings that must be observed by the user to ensure safe operation. Operating this instrument in ways other than detailed in this manual may impair the protection provided by the instrument and may result in the instrument becoming unsafe. Retain these instructions for later use.

The instrument is designed for use indoors in an electrical workshop environment at a stable workstation comprising a bench or similar work surface Instruments. The unit must be maintained and repaired by a skilled electronics technician in accordance with the manufacturer's instructions.

The instrument should not be installed in such a way as to inhibit access to the mains switch on the rear panel. This switch or the removal of the power connector are the prime means of disconnection from the supply in an emergency.

If it is likely that the protection has been impaired the unit must be made inoperative, secured against unintended operation and referred to qualified service personnel.

Protection may be impaired if, for example, the instrument:

- Shows signs of physical damage
- Fails to operate normally when the operating instructions are followed
- Has been stored for prolonged periods under unfavourable conditions
- Has been subjected to excessive transport stresses
- Has been exposed to rain or water or been subject to liquid spills

Caution

Electrical Isolation

Always disconnect the board under test from the local mains supply (including ground) before using this instrument. The TDR applies test voltages to the item under test. Make sure that the item under test is isolated from all other sources of electrical power. External power could damage the tester.

Static sensitive devices

This unit contains Static Sensitive Devices. Observe static precautions at all times.
**ATLAS 800 SPECIFICATIONS**

- **Relay Bandwidth**: >20 GHz (derived from maximum risetime)
- **Relay Impedance**: 50Ω (± 2%)
- **Discharge resistor**: 50Ω (+20/-10 Ohms)
- **Relay Life**: 5 x 10^6 operations/channel (typical)
- **Channels**: 2 or 4

**ATLAS 800 ENVIRONMENTAL OPERATING CONDITIONS**

The instrument is designed for indoor use only under the following environmental conditions:

<table>
<thead>
<tr>
<th>Altitude</th>
<th>Up to 2000m</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature</td>
<td>+10°C to +30°C ambient</td>
</tr>
<tr>
<td>Relative humidity</td>
<td>RH 80% maximum at 31°C — derate linearly to 50% at 40°C Non condensing.</td>
</tr>
<tr>
<td>Mains borne transients</td>
<td>As defined by Installation Category II (Overvoltage Category II) in IEC60364–4–443</td>
</tr>
<tr>
<td>Pollution Degree</td>
<td>2</td>
</tr>
</tbody>
</table>

**Power requirements**

- **Supply voltage**: 90 to 250V AC
- **Frequency**: 50/60 Hz
- **Input Current**: 0.1 o 0.07A

**Line Fuse values**

Time Delay 1.6A T
Physical characteristics (excluding accessories)

Temperature
- Operating: 10°C to 30°C
- Storage: 0°C to +50°C

Dimensions
- Width: 440 mm (17.375 in.)
- Height: 75 mm (3 in.)
- Depth: 420 mm (16.5 in.)
- Weight (2ch): 4.7kg (10.35lb.)
- Weight (4ch): 5Kg (11.1lb.)

Symbols

⚠️ CAUTION
On the rear panel the USB connector should be used to link to the controlling PC using the cable provided. A USB2.0 connection is required.

⚠️ CAUTION
Static sensitive devices — observe static precautions. A wrist strap is provided with the Atlas (connect the wrist strap to one of the sockets on the Atlas800 front panel).

*Note: The Atlas test system contains static sensitive devices — observe static precautions at all times.*

Note that the front panel ground sockets provided for wrist straps are not to be used for safety earth or ground connections. The safety ground connection is made through the power cord.

Lifting and carrying

The Atlas 800 can easily be carried flat using two hands and holding the case either side. No carrying handle is provided. Always place the unit on a flat sound surface feet down. The unit is designed to have the Tektronix TDR placed on top. However no other equipment should be placed on top of the TDR.

Cleaning

The unit may be wiped clean with a soft cloth moistened in water with mild detergent. Alternatively, a cloth moistened with isopropyl alcohol or ethanol (methylated spirit) may be used. Do not spray cleaners onto the instrument.
The Atlas 800 is intended to be used only as a part of the Atlas test system for the purpose of reducing the risk of ESD damage to the system TDR heads. Do not use for any other purpose.

When connected to power and turned on, the Atlas 800 should show a green power light on the front panel and then set the relays to “safe” condition which will be indicated by green leds at each channel.

Failure to achieve this state indicates a fault and the unit should be referred to a skilled technician for repair or returned to Polar Instruments.

A red light at a channel indicates that the relay is activated and the TDR connected to the probe. This condition should only occur while a test is being performed.

**Connectors**

The USB connector should be connected to the host PC using the USB 2.0 cable provided and according to the instructions in the Atlas manual.

The Probe SMA connector of each channel should be connected to the probe or device under test as instructed in the Atlas manual. Ensure cables are tightened using the Polar torque wrench to 5lbs/in.

The TDR SMA should be connected to the appropriate channel of the TDR using the cables supplied. Tighten using the Polar torque wrench to 5lbs/in.

The Aux jack enables a probe to operate the relay independently to the Atlas software. If the USB cable is disconnected or the Atlas software not running then a closure between the tip of the stereo 3.5mm jack plug and ground will activate the relay. This function is provided incorporated in some impedance probes to activate the static protection unit after the probe has been pushed fully down on to the test PCB.

The SMA cable from the relay going inside the enclosure is the discharge path and should not be removed or disconnected. If inadvertently loosened the SMA should be retightened to 5lbs/in with the Polar torque wrench.